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1.0 QUALITY ASSURANCE

1.1 UNIT DESCRIPTION

The Forensic Biology Unit is comprised of Criminalists, a DNA Technical Manager, a CODIS Administrator, a
Laboratory Technician, and two Supervising Criminalists. The unit is generally staffed from 0700-1700hrs
Monday thp@ugh Friday.

The Forensic laboratory is divided into three distinct areas on the 6th floor of the SDPD headquarters
building: the ntafh la tory area which is used for the purposes of screening items of evidence and the DNA
extraction process;‘a roomgledicated to PCR setup; and a separate area dedicated to the preparation and analysis
of amplified DNA. A

1.2 UNIT FUNCTIONS O

The Forensic Biology Unit aims to provide analysis on all reasonable requests from any investigative units of the

San Diego Police Department using the ent technologies available.

biological material, and perform DNA analysis on thg ical material.

The Forensic Biology Unit’s primary duties are tems of physical evidence to locate and identify

The biological materials that the Unit can presumptively id r confirm the presence of, are blood, semen,

and saliva. DNA analysis may be performed on all of these matgfFials ell as hair, bone, and other body fluids

or tissues. O

The DNA testing capabilities of the Forensic Biology Unit include both autbs nd Y-chromosome STR DNA
testing. L

Additional duties performed by the Forensic Biology Unit include the validation and i@ tation of new
technologies, courtroom testimony, and crime scene reconstruction. &@
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1.3 PERSONNEL AND JOB DESCRIPTIONS

1.3.1 SUPERVISING CRIMINALIST

The Supervising Criminalist of the Forensic Biology Unit will oversee the Forensic Biology Unit and analysts.

The responsibilities will include assigning casework, interacting with attorneys and detectives to determine
case pm, reviewing the work of all assigned analysts, and monitoring the overall job performance of

analysts. O
Duties and respo%ies: (The duties of Supervising Criminalist and DNA Technical Manager may be
A. Establishes casewoi ics based on negotiations and discussions with investigators and district

attorneys .

B. Assigns casework to analysts. (
C. Reviews reports and examines case 5@

D. Reviews and evaluates the performance of i tes.

E. Works with the DNA Technical Manager to revie %tablish Unit specific policies and analytical

G. Trains the new employees on department policies and procedure@ l

H. Works with the DNA Technical Manager to coordinate analyst training. O

assigned to a single

procedures when appropriate.

F. Interviews and hires new employees.

L. Keeps track of workload statistics. @

J. Prepares budget requests. @
K. Holds Unit meetings to disseminate department, laboratory, or unit specific information.

L. Prepares reports as required by the Crime Laboratory Manager.
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1.3.2 DNA TECHNICAL MANAGER

The DNA Technical Manager will oversee the technical operation of the DNA Laboratory as outlined by the
FBI Director’s Quality Assurance Standards for DNA Testing Laboratories. The DNA Technical Manager will
evaluate new technologies, resolve technical problems, assess and design training programs, and ensure the
unit adheres to all quality assurance guidelines. The DNA Technical Manager is authorized to shut down the
DNA laboratory should a serious technical problem develop.

Dutie%sibihties:

A. Responsiblgfforthe technical operation of the laboratory as outlined in the FBI Director’s Quality
Assurance Stanwor DNA Testing Laboratories.

B. Reviewing, revising approving any DNA-related technical policy or procedure prior to final

issuance by the Qua

including completion of trainifig documentation.

C.  Approving and overseeing raigg of new employees (when applicable) in DNA analytical procedures,

D. Overseeing, reviewing and approvin %= ethod validation, including completion of validation

O

E. Working with the Quality Manager on any Cor Action reports involving a DNA technical issue,
and reviewing and signing off on those Corrective ﬂ'e orts.

F. Acting as a technical reference for the Quality Manager. :

documentation, prior to final approval

Manager.

G. Performing some technical reviews of DNA case files.

H. Acting as a mediator when necessary in the technical review of DNAi c%k in the Forensic Biology
Unit. Q
I. Providing technical consultation as needed to the members of the Forensic Bi @t.

J. Working with Supervising Criminalists and Quality Manager to ensure compliance D@NA analysts

with QA and unit policies and procedures.

K. Reviewing the DNA proficiency tests completed by the Forensic Biology Unit.

L. Conducting casework analysis.
M. Prepares reports as required by the Crime Laboratory Manager and Assistant Crime Laboratory
Manager.
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1.3.3 CODIS ADMINISTRATOR

The CODIS Administrator is responsible for the security and integrity of the local CODIS network, the
CODIS software, and the data within the local database. The CODIS Administrator ensures the data within
the local CODIS database is in compliance with NDIS guidelines. The CODIS administrator is authorized to
terminate an analyst’s or the laboratory’s participation in CODIS until the reliability and security of the

computer data can be assured if an issue with the data is identified. If the CODIS Administrator determines at

at the CODIS network, software, or entered data has been compromised, the DNA Technical
Manager seimmediately notified. The DNA Technical Manager and CODIS Administrator will
ourse of action to reinitiate participation in CODIS for the analyst(s) or laboratory.

Duties and responsib%

A. Oversees the enterin@ rofiles from casework into the local database.

determine

B. Ensures that DNA profiles arg searglted against the local CODIS database.

C. Uploads data to the California CO abase.
D. Downloads and searches DNA profiles fr S WAN website.
E. Performs upgrades to the CODIS software with t ance of the CODIS Help Desk.

F. Ensures that a backup is maintained for the informationﬂn%l database.

G. Schedules and documents the yearly training of analysts in the o of CODIS software.

H. Disseminates CODIS information to the rest of the Forensic Biology it. l

1.3.4 CRIMINALIST (I AND II) %

The job descriptions for Criminalist I and II are similar except that Criminalist II duties maybe faore extensive
and Criminalist IT analysts are expected to work more independently. In addition to the normal educational
requirements of the Criminalist position, DNA Criminalists must complete college-level classes in

Biochemistry, Molecular Biology, Genetics, and Statistics and/or Population Biology.
Criminalist I and II’s primary duties involve locating and identifying biological material on items of physical
evidence and performing DNA analysis. Analysts are required to document all exams, tests, observations,

results, summarize the findings in a written report, and if necessary, testify in courts of law.

Duties and responsibilities:
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A. Receives, inventories, screens, and preserves items of physical evidence.
B. Locates and identifies biological material.

C. Conducts DNA analysis to determine possible associations between the evidence and any reference
samples provided.

D. Ti eports summarizing the findings and provide expert testimony in court.
E. RemainSEn' y current and knowledgeable in appropriate analytical methods.
F. Participates in th I#ation and validation of new technologies or methodologies.

G. Participates in any spe@ ts as assigned by the Supervising Criminalist or Laboratory Manager.

case.

[.  Uses the technical manual, unit policiei@ and general quality assurance manual to deal with any

H. Informs the Supervising Cri n%r DNA Technical Manager of problems that develop at any stage of a

procedural question or analytical method.

1.3.5 LABORATORY TECHNICIAN ,y

The laboratory technician functions as a support position for theiology Unit. Duties include
D

ordering supplies, calibrating instruments, monitoring operating te of equipment, performing

maintains a database of all chemicals ordered by the Unit. If the position of'La ry Technician is unfilled

routine maintenance of equipment, and cleaning the unit on a weekly sdlie !The laboratory technician

the duties and responsibilities will be shared among current employees. Certain functiéns described above may
be performed by volunteers or interns but only under the direct supervision of the {abo technician or
other qualified analyst. SS

Duties and responsibilities: @

A.  Checks the calibration of instruments such as pipettes, thermal cyclers, and balances.
B. Orders chemicals and supplies for Forensic Biology
C. Maintains an accurate inventory of all chemicals located in the Unit.

D. Ensures that laboratory instruments, communal work areas, and floors are cleaned and decontaminated.
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E. Ensures that the operating temperatures of the Unit ovens, incubators, refrigerators, and freezers are
monitored.

F.  Ensures that victim, suspect, and physiological, and reference mouth swab kits are prepared for
departmental use or for the collection of evidence at area hospitals.

G. Performs other tasks as assigned by the Supervising Criminalist.

1.3.6 %VOLUNTEERS

Interns (studentsyand volunteers (non-students) will assist the Unit by performing certain clerical duties,
cleaning the laborator,

will always be performed the guidance of the Laboratory Technician or Criminalist. The Laboratory

Technician is ultimately re

rk areas and monitoring the operating temperature of equipment. These activities

or making certain any duties completed by the interns and volunteers are

performed correctly.

Depending on the experience level of i or volunteer they may also be involved in laboratory projects
such as the validation of new technologies. Fhigvalidation work will always be performed after receiving the

appropriate training and qualifying tests, an Osupervision of the DNA Technical Manager.

1.4 TRAINING PROGRAM

1.4.1  The training program information will be maintaine i@ ensic Biology Training Manual.
1.4.1.1  Documentation of training program completion intained by the Quality
Manager.

1.4.1.2  Documentation of training and competency for new methods willJfe maintained by the
Quality Manager.

1.4.2  Each analyst will be provided 8 hours (cumulative minimum) of documented t@ ., continuing
education) per year in subject areas relevant to the development in DNA typing.
1.4.2.1 Documentation of completed continuing education will be maintained by the DNA
Technical Manager.

1.4.2.2 Documentation of internal training will include:

1.4.2.2.1 Title of the training presentation/program;
1.4.2.2.2 A copy of the presentation/training provided;
1.4.2.2.3 Date of the training/presentation;

1.4.2.2.4 Attendance list;
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1.4.2.2.5 Hours of training; and

1.4.2.2.6 If the presenter is external to the laboratory, the presenter’s CV. (Note that
trainer’s internal to the Crime Laboratory have their SOQs on file in
PowerDMS).

1.4.2.3  Participation and completion of programs based on multimedia or internet delivery must be
formally recorded and approved by the DNA Technical Manager.

1.5 L%E REVIEW
I

1.5.1 Annua ? of scientific literature will be documented within the laboratory’s document

manage an (i.e., PowerDMS).

1.5.2  Analysts W1th1n g ensic Biology Unit will be provided copies of relevant literature (at least one
full article, abstra & cellaneous publications) periodically throughout the year.

1.6 TECHNICAL LEAD CONTIN %
1.6.1  The Forensic Biology Unit of the Sap

who meet the requirements to be D

do Police Department currently employs multiple analysts
ical Manager. In the event of a vacancy in the DNA

Technical Manager position the Crime L& Manager will interview the candidates and appoint

I

a person to fill the vacancy.

1.7 NON-CONFORMING WORK

1.7.1  Quality Incident Summary forms (FB network H:\ Worksh orksheets) will be completed
by analysts for:
*  any malfunction or problem with laboratory equipment,

*  when control samples fail to provide the expected results,
*  when a technical policy or procedure was violated in the process of arfalysigf’or

*  when a potential association is made to the elimination DNA database.

1.7.2  Quality Incident Summaries will address the following (if applicable): @

1.7.2.1 Definition and evaluation of the non-conformance
1.7.2.2  Actions Taken to address the non-conformance
1.7.2.3 Root cause (if determined)

1.7.2.4 Reported results opinions or interpretations

1.7.3  Quality Incident Summaries will be submitted to the DNA Technical Manager, or designee, for

further evaluation. If corrective actions are required, as defined in section 8.7 of the Quality Manual,
the Quality Manager will be notified.
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1.7.3.1 Non-conformances will be evaluated to determine its significance or impact on the current
analysis.

1.7.3.2  Non-conformances will be evaluated to determine its significance or impact to previous
analysis. The Quality Manager will be notified if previous work is deemed to be affected.

1.7.3.3  Appropriate actions will be taken to remediate non-conformances. Appropriate actions will
be determined based on 1.5.3.1 and 1.5.3.2.

1.7.4 uality Incident Summaries will be tracked to identify trends. If a trend is identified, the Quality
apager will be notified.

1.7.5 Nf mances involving failed controls or potential associations with the elimination DNA
dataase%likelihood ratio HPD values greater than 99 will be disclosed in the report.

1.8 PROFICIENCY TEST@

Please refer to the Laboratory Qali anual for additional information on the proficiency testing Program.

1.8.1 Each DNA analyst in the Foyénsic Biology Unit must complete two external DNA proficiency tests in

each calendar year with an in tween the tests of no less than four months and no more than
eight months. é

tests are tracked.

1.8.2  The due date of the proficiency test (as l. ;Ee provider) will be the date by which proficiency

1.8.3  Atleast one proficiency test per year will involv ;dcntification

1.8.4  Proficiency tests will be worked in the same manner as cas and undergo both technical and
administrative review.

1.8.5  Autosomal STR and YSTR testing (for those qualified) must be r p semiannual proficiency
test.

1.8.6  YSTR testing must be performed on each sample that has male DNA deteQ

Note: If'a sample containing male DNA has multiple fractions (i.c., sperm and non-sperm iofts), only one

fraction must have YSTR testing performed on it.

1.8.7  Analysts must enter into the proficiency testing program within 6 months of completion of the

training program.
1.8.8  The DNA Technical Manager will compare the results obtained by each analyst to the consensus
results from the test provider, determine the outcome of the test, and inform analysts of the

outcome.

1.8.9  Analysts will initial their proficiency test packets, acknowledging the outcome of the test.
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1.8.10  Proficiency tests will be maintained by the Quality Manager.

1.9 FORENSIC BIOLOGY COMPUTER NETWORK SYSTEM

The Forensic Biology Unit employs an independent network system comprised of several servers and client
computers 3§ share electronic data among criminalists, link instrumentation, maintain a centralized storage of
data, an yifle a secure connection to the Combined DNA Index System (CODIS).

1.9.1 @%NIC DATA STORAGE

Data backup is per%automatically and is managed through the Data Systems Department of the San
Diego Police Depaffm t‘ lease contact SDPD Data Systems for additional information regarding the

management and securit] e Forensic Biology computer network.

1.10 QUALITY CONTROL AN C ICAL REAGENTS

1.10.1The following list contains the reﬁ med critical to the DNA testing process:

"  All reagents used in the extraction of D dlng dithiothreitol (DTT))
"  Qiagen DNA Investigator and QlaSympho DIX estigator Kits
®  All Quantifiler gPCR Kits

= All Autosomal or Y-chromosome STR Typing Kit 4

p—

.10.2SAMPLES AVAILABLE FOR QUALITY CONTROL E

be quality tested using dried blood samples. DNA typing and quantificatio

previously extracted DNA samples. O

1.10.3 QUALITY CONTROL TESTING OF CRITICAL REAGENTS @

Only samples with known DNA profile results will be used to assess cri nts. Extraction reagents will
jﬂbe quality tested using

1.10.3.1 Before any critical reagent can be used for casework analysis it must undergo @control
testing.

1.10.3.2 Quality control analysis will undergo technical review and review by the DNA technical
Manager, or designee.

1.10.3.3 The results of controls, NIST SRM, and known samples must be in complete agreement with
their expected results order for a critical reagent to pass QC.

1.10.3.4 In the event that the QC data does not pass, a second QC analysis will be used to confirm the
original result.
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1.10.3.4.1  If the second QC analysis demonstrates the reliability of the kit, it may be used for
casework analysis.

1.10.3.4.2  If the second QC confirms a problem with the critical reagent, then the critical reagents
tested will not be approved for casework and, if applicable, the vendor of the reagent will
be contacted.

1 %‘:ritical reagents/kits will be tested as follows:

Extraction Réggenss: <Cwo different known samples and a reagent blank will be carried through DNA extraction
and typing. The pytparation dates of the reagents and the results of the DNA testing will be documented on
the Quality Control Weet for Critical Extraction Reagents.

Qiagen (EZ1 or QiaSympho

(note: concentration factor nog

A Jnvestigator kits: Two different known samples and a several concentrated
oQA ced 8x) reagent blanks (for EZ1 only: some eluted in TE and some
eluted in water) will be carried throughdDNA extraction and typing. The kit, reagent strip lot numbers, and
the results of the DNA testing will b@ted on the Quality Control Worksheet for DNA Investigator

kits.

Quantifiler Duo kits: The DNA standard tubes froew lot of Quantifiler Duo kits should be defrosted,
pooled, and re-distributed into the DNA standard test new lot of kits should be used to quantify

kits. Two samples with known genotypes should also be qua

calibrators 1 and 2 from the old lot of kits as well as three re tes of calibrators made with the current lot of
yc sing the new Quantifiler Duo kit(s), the
le

i
obtained quant values should be used to amplify those samples (apfl appropriate controls) using one of the
validated typing kits. All samples should produce the known genotd the peak heights should generally
be consistent with expectations based on the input amount of DNA. t volume of the QC samples
will be determined based on the quantification value obtained from the ne (%ntiﬁler Duo Kit. Successful
typing of the known samples will serve to demonstrate the reliability of the n it lot(s).

the 007
Control DNA positive control and an amplification blank. The lot numbers of all kit comp&gents and the
results of the DNA testing will be documented on the Quality Control Worksheet for GlobalFiler.  (See also
the NIST Testing policy below)

GlobalFiler DNA typing kits: 007 Control DNA should be defrosted, pooled, and re- el into the DNA
standard tubes prior to performing the QC testing. Two known samples will be typed a

Yfiler Plus DNA typing kits: New kit lots will be tested with two known male samples, the 007 DNA positive

amplification control, and an amplification blank. The lot numbers of all kit components and the results of the
DNA testing will be documented on the Quality Control Worksheet for Yfiler.

All QC data will be stored electronically on the FB network.
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1.11 NIST TESTING OF DNA PROCEDURES

Once a year, the DNA typing process will be checked against NIST or NIST-traceable standards. Previously
extracted known DNA samples can be tested alongside NIST SRM samples, thus making them NIST traceable. If
kits are quality controlled using these NIST-traceable samples, this check will serve as the yearly check against
NIST standards.

1.12 EQ @T VERIFICATIONS
Ework.

1.12.1 A new crj equipment (1.11.2) will require validation, or verification prior to implementation

1.12.2 Verifications wil drformed on the equipment that has been identified as critical to the analysis of
samples in the Folen gy Unit. The equipment listed below will be assessed at the

o
n
verification will be performed

into cas

approximate interval ed. If any of the instruments in the list is taken out of service a
ior to re—initiating casework on the instrument.

Equipment Item Location Schedule (approximate)

Pipettes Forensic m Lab and Amplification Room Every six months
Balances Forensic Biology Myj Annually

and Amplification
BioRobot EZ1s Volume Test Forensic Biology Main Ifab Every six months
QIASymphony Forensic Biology Main Lﬁ Annually
QiaCubes Forensic Biology Main Lab v } Annually
Hamilton Nimbus Forensic Biology Main Lab M ﬁ Every six months
Thermal cyclers Amplification Room V Every six months
SDS 7500
Block Contamination Check Amplification Room }‘Every six months
All other calibrations Agmally
Genetic Analyzers Amplification Room Cnn@y
Corbett CAS-1200 Amplification Room

al
¥
See the equipment maintenance section for additional information on equipment ca&

1.12.3  Pipettes will be verified by an external service provider based on the pipette manufacturer’s
systematic (accuracy) and random (precision) error tolerances.

1.12.4 VERIFICATIONS

If any maintenance, repair, or service is conducted on a piece of equipment, a performance verification will
be performed.
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1.12.4.1 QiaCubes - preventive maintenance will be performed on the instrument on a yearly basis.
After any service visit, including the yearly preventive maintenance, the QiaCube(s) will be
evaluated with a performance verification. This verification will aim to establish if the
instrument performance is acceptable for casework applications. This is accomplished by
determining if the service issues were corrected and that the instrument(s) can still perform
the methods as expected. One way of determining this is to run a set of mixed sperm/non-
sperm cell samples through the QiaCube and continue the analysis through both quantification,
amplification, and CE analysis. Satisfactory performance will be determined by the ability to
separate the sperm and non-sperm fractions of the verification samples.

obot EZ1s — every six months a volume test will be conducted on all BioRobot EZ1s to
ine whether pipetting performance is still optimal. See the equipment maintenance
otocolgsection (section 6) for additional information. A passing result must be within 5% of
the pi volume for all channels within the instrument.

1.12.4.3

basis. As part eventive maintenance visit, the pipetting accuracy and precision are
checked for all 4 ¢hann

. After any service visit, including the yearly preventive maintenance,
e evaluated with a performance verification. This verification will aim

service issues were corrected and that the instrument(s)
can still perform the methods d. One way of determining this is to run a set of
samples through both quantificatic and amplification setup protocols. Replicate
samples could also be run on the Bio 1(s) to demonstrate satisfactory performance.
1.12.4.4 Hamilton Nimbus — preventive mainteffantg will be performed on the Nimbus instruments
approximately every 6 months. As part of thepregntive maintenance visit, the pipetting
accuracy and precision are checked for all 4 channel is documented in the volume

verification report.

After any service visit, including the yearly preventive mai %the Nimbus instruments
ion aim to establish if the
is agcomplished by

will be evaluated with a performance verification. This verifi wi
instrument performance is acceptable for casework applications. Thj
determining if the service issues were corrected and that the instru

7]

still perform
the methods as expected. One way of determining this is to run a set of §a hrough both
quantification set-up and amplification setup protocols. Replicate samples e tsed to
assess pipetting volume accuracy and precision during the quantification setu

Any changes to the methods (i.e., robotic instructions underlying the procedure) will require a
modification study to determine whether the changes have adversely affected performance.

1.12.4.5 Genetic Analyzers - the QC analysis of critical reagents will serve as the annual performance
verification of the Genetic Analyzers. The QC runs performed for the various testing kits
employed by the lab will be rotated through the various Genetic Analyzers throughout the
course of the year. Performance checks separate from QC runs may also be done using a

minimum of the amplification positive, amplification negative and allelic ladder.
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After any service visit, including the yearly preventive maintenance, genetic analyzers will be
evaluated with a performance verification. This verification will aim to establish if the
instrument performance is acceptable for casework applications. This is accomplished by
determining if the service issues were corrected (if applicable), electrophoresis capabilities
(i.e., resolution) are acceptable, and that the sensitivity of the instrument has not been altered
substantially. One way of determining this would be to evaluate data from a set of samples run

pre-service and comparing it to data from the same samples run post-service.
4(

orbett CAS-1200 — the performance check of the CAS-1200 will consist of an evaluation of
‘ ;e instruments pipetting against manual pipetting of the same samples. This will be
%lished based on the CAS-1200 pipetting of a known set of replicate samples for analysis
the gemetic analyzer. The results of the replicate CAS-1200 pipetted samples will be
comp, against the same replicate samples prepared manually. Total detected peak heights

of both se ﬁ ples will be used to measure the performance of the CAS-1200. Although
several variablgé affect the ultimate peak heights on the 3500, ideally the difference
between the tafa heights both sets of samples should be less than 10%.

1.13 POLICY FOR MONITORIN@C ATORS, REFRIGERATORS, AND FREEZERS

The incubators, refrigerators, and freezers in nsic Biology Unit will be monitored approximately every

a worksheet attached to the equipment. Refrigerators
will be expected to operate at a temperature betwee and freezers at a temperature colder than -10°C.
Consistent deviations from the expected temperature indic hat maintenance or repair is likely required and

1.13.1 MICROSCOPES

The microscopes in the Forensic Biology Unit will be maintained accorn@) licies outlined in the
laboratory Quality Systems Manual.

DS

week. The operating temperatures should be re

the Supervising Criminalist of the unit will be notified.
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1.14 QUALITY ASSURANCE DOCUMENTATION IN THE FORENSIC BIOLOGY UNIT

This list below indicates all the logs maintained by the Forensic Biology Unit:

Kit Receipt Log Electronic

Electronic

Electronic
DNA Extracsiof % Electronic
Qiagen Robot RJgent Electronic
GlobalFiler QC % - Electronic
Y-STR QC f Electronic
Quantifiler Duo QC \) A Electronic
Unexpected Results @ V. Electronic
FB Incident Log ( Electronic
Staff Associations ‘ﬁ Electronic
Balance Calibration Tests (Quarterly) v Electronic
Pipette Calibration Electronic
Nimbus Maintenance l&tronic

Thermal Cycler Calibration & Uniformity

3500 Maintenance

lec ic
Eﬁi%

Ovens & Fridges Temperature Log

Electragfic

N\

Qiagen EZ1 Volume Test

Electronic

QiaCube Maintenance

Electronic

%
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2.0 TECHNICAL RECORDS

2.0 REPORT FORMAT

The Biology Unit will use the standardized report format located in the Quality Manual. Where available, CII

numbers will be included in the report.

2.0.1 41 BACKGROUND SECTION
ckground section of the report will only be used for:

2.1

2.0.2

2.0.3

cing external data used to render conclusions in the report.

cribing corrections to, and referencing, original reports in Report Amendments.
n
e%—n

CASE-T(M NOTIFICATIONS
Will be issued ociations between evidence items in different cases, or associations to

individuals in ses. These notifications must be administratively reviewed prior to

issuance.

Case-to-case notification% required when any SDPD cases have been associated through the
database to any other SDP
case notifications will be issued for. ewly associated cases. Cases previously associated with the

same individual do not require no tQ

FB analysts will issue case-to-case notifi he following scenarios:

" Associations to cases without a named individ

" Associations to individuals without CII or entification numbers.

The FB Laboratory Technician (or other designee) will i@sc—to—casc notifications in the

following scenario:

= Case associations to named individuals with CII or FBI iden; 1c:jton number.

ases from an outside agencies, or a named individual. Case-to-

SCREENING REPORTS

Screening results can be summarized either through the inclusion of a ta@ ough written
explanations of the results. &

CASE PACKETS

The final packet assembled by the analyst will contain the original of the final signed report, complete

analytical record (or a reference as to where the data is located), and the work request(s) for scanning and

storage by the Clerical Unit. The final packet is subject to technical and administrative reviews before the

packet is filed.

If any information is referenced within the analytical record (e.g., a reference sample worked as part of a

different case), a pink sheet indicating that the report relies on information contained within a case packet
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from a different case. This sheet will serve to notify clerical that additional material is required in the event

of a discovery request.

2.1.1

ANALYTICAL RECORD
In general, the analytical record will contain the following:

Documentation of relevant communications

DNA extraction, quantification, amplification, and capillary electrophoresis notes

¢ Evidence inventory and analysis notes, lncludlng any serology tests results

2.1.2

NA results (electropherograms)
retation information/worksheets
& results page with diagnostic information of the MCMC
atistic Valuatlons

COD sheets printouts for any samples to be uploaded to CODIS
DISpOSItIO mation for work product

CASEWORK BA G

To streamline the adniinistrafive burden (case, packet assembly, technical review, and

administrative review) ofrocessing large numbers of cases together, analysts may group the
analytical records for multi s together into a single analytical record. Each case in the
casework batch should receive i éldividual report.

Alternatively, the analytical worksheet @ 1

X) can be technically and administratively g

on to multiple cases (i.e., extraction through GMID-
@ ed separate from the complete analytical record.
The technical and administrative reviews shall

be mented in the complete case packet, and the
analytical batch only referenced. These analyti chés must be stored on the FB network such
that they are available for review when the compldte giffe packets are reviewed. Please see section

2.6.1 for additional information on technical review.

NOTETAKING
2.1.3.1 Notes will be taken contemporaneously with examination or analysis.

2.1.3.2 The analyst will take notes with the expectation that they, a techni€al g&jewer, or other
person with foundational knowledge, upon review will be able to r¢cohstiact what was
6i1§

done in terms of examinations conducted, testing completed, and any
2.1.3.3 Page numbers and analyst initials will appear on each page of the technical record.

2.1.3.4 Technical record pages will reflect the date upon which the laboratory activities were
conducted.

Note: Emails, electropherograms, and STRmix report pages that contain dates do not
require additional dates on them unless notations are made after the initial
printing/interpretation of the data.
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2.1.3.5 Analysts should avoid using the names of victims of sexual assault or child abuse cases on
worksheets containing information from multiple cases to reduce the risk of the
information being revealed through the discovery process for unrelated cases.

2.1.3.6 The condition of evidence packaging will be noted (e.g., damaged, unsealed, etc.) when
evidence is retrieved from the Property Room or Laboratory Vault.

2.1.3.7 Photographs will be labeled with a descriptor unless it is completely evident what the
¢ photograph represents. Photographs should include scale.

ily retrieved, if needed, for discovery. Ata minimum, the electronic files of the

@ gital photographs taken in the Forensic Biology Unit will be archived so that they can be

photagraphs should be saved with the barcode of the item in the file name in a folder
1&5 W

ith the case number.

2.2 INTERPRETATION OF OLS

2.2.1 SUBSTRATE CONTR[{

For any analysis, a result obtained from a ed stain is interpreted as being representative of the stain

when the result from the substrate control 1 @

Results from questioned stains for which the substrafe rol yields a positive result need to be interpreted
with caution. A result from a questioned stain may no resentative of the stain when the substrate
control also yields a positive result. In this circumstance, the r obtained from the questioned stain

Some considerations for evaluating the substrate control include:

need to be considered along with the results obtained from the s control.

A. The collection of the substrate control (e.g., was the control collected from agfroven negative arca?)

B. Results from presumptive test versus a quantitative test. Was the substrate cont@i ally evaluated

as being negative by a presumptive test, which is less specific than the confirmator

C. Did the substrate control give a low level DNA result versus a considerably higher level DNA result
from the questioned stain?

D. The source of the substrate. Is there a stain on the substrate control, which was not identified
presumptively, which could be giving the result? It may be necessary to examine the substrate for other

body fluids.

2.2.2 DNA CONTROLS:
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Please refer to the Autosomal STR Interpretation Guidelines (or Y-STR Interpretation Guidelines section)
section of the Forensic Biology Technical Manual for the policies regarding the interpretation of the

Reagent Blanks, Positive Amplification Controls, and Negative Amplification Controls.

2.3 CASEWORK REVIEW

All caseworl#pgrfoymed by the Forensic Biology Unit is subject to both technical and administrative reviews.

eview policy in the Quality Manual.

2.3.1 TECHNI%EVIEW

2.3.1.1 Each techno d in the Forensic Biology Unit will have a technical review conducted on it
quali

by a second

alyst.

2.3.1.2 Technical review will ée between all qualified analysts in the Forensic Biology Unit to
e

ensure that the proces irf§ objective.

2.3.1.3 Technical review will ensure racy of the final report and that established Forensic

‘Q

Biology protocols and policies art pplied to case analysis.

2.3.1.4 Technical review will ensure that the cénc ns in the report are supported by the data in the
analytical record (i.e., case notes, sketche s, etc.).

2.3.1.5 If changes are made as a result of the technical re fect the opinions and interpretations

in the report, the authorization date must be updated ect the date of those changes.

2.3.1.6 In general, technical review will be completed within two cglendfr weeks. Additional analysis,
training, or vacations may delay completion within the stated ti ame.

2.3.1.7 Analysts submitting technical records for review must communicate%v timelines to the

technical reviewer.

2.3.1.8 Unresolved differences between the case analyst and the reviewing analyst w@ediated by
the DNA Technical Manager.

2.3.1.9 The date of the completion of the technical review will be documented in the report and in the
analytical record.

The following list is meant to guide analysts in providing a complete technical review of case packets. The
list is not meant to be all inclusive and a case needs to be evaluated in its entirety to make certain that a

reasonable, competent, and complete analysis was performed.
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Analytical Record
DNA request has supervisor initials
Notation from supervisor or communication with detective documented for requested samples that were not
tested
All other requested evidence and reference samples tested

Case file has pink case reference sheet, if applicable
Date, initials, page numbers, and case # / incident # on each page
Cgrrections are lined out, initialed, and dated (if applicable)
pplicable, permission to consume evidence obtained and/or communicated
pPegtant communications concerning the case appear recorded

Eviden apli

There 1s an
There is aj ad%ritten or pictorial representation for evidence examined

written or pictorial representation for samples collected

cquate description of the evidence packaging

There is an ad

Proper methods were ustd entify biological fluids
Appropriate controls were tised fof alternate light source and presumptive tests

Substrate controls collected an: alyzedgvhere appropriate

Documentation present that eviderte ckaged and sealed
Sub-item designations added to packag mments section in FileOnQ
If applicable, "SART Kit Tested" field is u; ileOnQ or SARTonQ.

Analytical Notes @
Reviewed (TR/AR) Analytical Batch review page pfe if applicable
Analytical notes not part of analytical batch contain n documentation
If applicable, Quality Incident Summary documentation prgsent ilpotes or in Analytical Batch
Suitable amounts of DNA amplified for evidence and controlsgfor the=STR system
Positive Control results acceptable O

Amplification Blank (TE) results acceptable

All associated Reagent Blanks have acceptable results

Electropherograms
Appropriate analysis method, panel, and size standard used for all samples
Electropherograms present for all relevant samples

If altered injection times used, controls were injected appropriately @

Multiple injections performed where necessary

If multiple injections performed, results generally consistent/ expected

Artifact and allele changes labels appropriately and sufficiently

Loci with common microvariant alleles (X.1 or X.3), have no stutter peaks or alleles above detection

threshold that did not fully resolve from neighboring peaks

Heterozygous peaks in apparent single source samples appear to be balanced
Interpretation

Assumptions regarding number of contributors are documented

Conclusions based on visual comparison are documented

STRmix run for all appropriate samples

STRmix input files imported correctly for evidence samples
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If applicable, MCMC conditioned on appropriate references and the text file was imported appropriately
MCMC results appear to have appropriate genotypes, weights, and mixture proportions

If applicable, MCMC run with appropriate informed priors

STRmix database search results evaluated for possible staff matches

Comparisons were made to all relevant reference samples and the input files were correct

LRs do not have large disparities in results at any loci (i.e., LR = 0 at only a single locus)

STRmix diagnostics within reasonable range of values
Ear Y-STRs, designation of major and minor contributors is appropriate
@STRS, appropriate comparisons were performed and conclusions drawn
@s, appropriate statistical assessment of evidence performed

CODI
CODIS shgfts present for applicable evidence

If applicable, %alculated appropriately for eligibility for SDIS/NDIS

CODIS sheetsPresentfar applicable suspects
All CODIS sheets h @ ropriate case #, item #, contributor %, specimen category, and offense

information

All CODIS profiles havefco specimen category and DNA types
Report

Header is correct on first page 4d corrgat on additional pages

If applicable, Supplemental Reportﬁd ackground are appropriate

Evidence examined contains correct bdrgh u’

d appropriate description of items

Evidence examined contains results of presd confirmatory testing

DNA typing kit(s) listed in Evidence Examinet clusions
Conclusions have appropriate barcode and descri fraction for diffs)
Conclusion lists number of contributors and mixture pr ons, if appropriate

Conclusions include appropriate verbal wording for LR forjeach dantributor

Reported LR for inclusions use lowest HPD for all four populgftio

Point LR reported for inclusions with no effective sample size, ai ns with greater than 10°
difference between LR and HPD

Disposition of evidence present

Signature block is correct F

Analytical batch(s) listed in report

If applicable, Quality Incident Summary documented appropriately in report

ANALYTICAL BATCH REVIEW

The review of an analytical batch (see section 2.2.2) is designed to streamline the reviewed process by not
requiring duplication of data review. The following list is meant to guide analysts in providing a complete

technical review of the analytical material in a batch.

Packet

Date on each page

Initials on each page
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0 Page Numbers on each page
O Analytical batch name on each page
O Corrections are lined out, initialed, and dated (if applicable)
Extraction Worksheets
O Appropriate volume of Digest Buffer/ Prot. K (and DTT)
O Correct Preparation date for Digest Buffer/ Prot. K (and DTT)
A D Incubation time 2 required minimum

Appropriate elution volume

TE or dH2O Elution box checked

1 instrument indicated for each sample

Corregt Reagent Strip Lot #
Xlanks included

Quantitation Worksheets

Correct Duo lot #
7500 Instrume 1ste%

Setup listed

Master Mix Preparat accurately calculated

Calibrators are within ap
TE Amp Blank is undet and I
All reagent blanks are undet and IW

Amplification Workshieets
Correct Amplification Kit (GlobalFiler 0’@1 lot #
Correct TE Prep Date }
Thermal Cycler Instrument listed i ( ) R
Setup listed Ay

Master Mix Preparation was accurately calculated @ !

Correct volume for Positive Control added )

Correct volume for TE Amp Blank added /

If samples combined, corresponding RBs are combined V (\

Correct volume for Reagent Blanks added \)6\

(&§

Dilutions (and/or) concentration procedures listed below table

¥

3500 Sample Setup Worksheets

Formamide Blank and Formamide ISS included

Ladders included

Positive and negative control included

Reagent blanks included

3500 Instrument listed

Sample setup listed

O|0 |00 |0|0|0o O|o0|(o|0|0|o|0|0|o|Oo O|0|(o|0o|0o|o|o DD(D);

Correct Reagent Lot #s (Formamide, ISS, Ladder)
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GeneMapper Analysis (electronically viewed)

Sample page included in packet

At least 1 evidence and 1 reference ladder passed

All GS600 — Appropriate peak heights and resolution

Positive Control passed
TE Amp Blank (No detected DNA types)
A O All Reagent Blanks (No detected DNA types)

oo ({o|0|0o

/

TECHk@EVIEW EXPECTATIONS

The following rves aE:a further clarification of the expectations with regards to the technical review

process should diff ¥ of opinion arise:
1. The Analyst and Te viewer will meet in person and have a verbal conversation in an effort to
sort out any differences‘f ion. Each should have the opportunity to professionally explain their

point of view.

2. Assuming the analyst and techfiical regiewer cannot come to an agreement; the input of a DNA

Technical Manager will be sought:
3. Should the issue raised in technical révi

consider a policy change. In this case, t ical Manager will work with the Supervising

Criminalist(s) and/or the Quality Manager ine the best course of action.

4. Assuming an agreement between the Analyst, t. nical Reviewer, and Technical Manager cannot
be achieved, the Quality Manager will be asked to fissiststhe three parties in coming to a resolution for
the technical issue.

5. Should the technical review issue still remain unresolved Supervising Criminalist for Forensic
Biology will be informed of the impasse. Q

6. Analysts involved in the discussion may elect to have further with the Crime Laboratory

Manager concerning the technical issue. l

2.3.2 ADMINISTRATIVE REVIEW

Each case packet prepared by an analyst is subject to administrative review. This revi@ormally
conducted by the Supervising Criminalist; however, in the event a Supervising Criminalist j§ uigvailable the

administrative review may be performed by another analyst within the section.

The Quality Manual details the basic elements of the administrative review process. In addition to those
criteria enumerated in the Quality Manual, the following list is meant as a guide to providing a complete
administrative review of case packets. The list is not meant to be all inclusive and a case needs to be

evaluated in its entirety to make certain that the report and analytical record are complete.

Notes

Worksheets are complete?
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Report

Conclusions in the report are supported by the data?
Statistical frequencies provided for DNA profiles when appropriate?

Evidence disposition is summarized?

General

Report and case notes have had a technical review by a qualified analyst?

was corrected or otherwise resolved all concerns raised by the analyst performing the
techhiCalamgview?

CODI sheets for appropriate samples?

'}cd, has SART-on-Q or File-on-Q has been updated (as applicable)?

CA

3.0 EVIDENCE POLICI@

3.0 CASE SUBMISSIONS

The Forensic Biology Unit accepts case su ongfrom all investigative units with the Department. Case

submissions are handled as described in the Q anual.

Department Order 13-30 requires a consent form WQ ing DNA from a subject who is not being arrested
for a felony, is not a 4th waiver subject, is not subject to'a cblirt order mandating collection of a DNA sample, or
)
the z

inform the subject of his or her right to refuse
to have a sample collected, and will inform the subject that e, 1f collected, may be entered into a

database for comparison with other profiles. Any reference DNA sauested must have a form submitted

restee, court order, 4th waiver

who is not a victim of a sexual assault. The consent form is

in order to have the sample analyzed, unless it has been collected from
subject, or sexual assault victim. If no form was collected, permission from t istant Chief in the requestor’s
chain of command will be required to proceed with analysis. The consent form ocumented Assistant Chief

approval will be maintained as an administrative document.

3.1 CONSUMPTION OF EVIDENCE &9@

Analysts will adhere to the consumption of evidence policy in the Quality Manual.

3.1.1  If the decision of an analyst is that consuming an item of evidence provides the best chance of
obtaining a DNA result and there is an issue with the laboratory consuming the evidence, an analyst
may agree to initially consume half of the sample (predicated on the subsequent analysis of the
remaining portion of the evidence if needed) or may suggest that an independent laboratory be
selected to perform the analysis.
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3.2 FACILITIES AND EVIDENCE CONTROL

See the laboratory’s Quality Manual for lab-wide policies regarding facilities and evidence control. The

following are additional unit policies:

3.2.1  Separate areas are designated within the Unit for evidence evaluation and DNA extraction, PCR
setup, and for the amplification and analysis of amplified DNA. Procedures will be performed in

@he appropriate area for that analysis.
3.2.2

>s used in post-amplification processes must not be used in the pre-amplification areas
vithGut rough decontamination and cleaning.

3.2.3  The door %oom containing amplified DNA will remain closed except for passage.

3.2.4  Amplified DN@O be stored in the refrigerators and freezers in the post-amplification area.

the pre-amplification area

3.2.5  Noreagents used in t p?mplification processes will be stored in any refrigerator or freezer in

3.2.6  Evidence and reagents should belst separately in their designated locations while in the
Forensic Biology Unit.

3.2.7 Records will be maintained in the ReaQ ation Log for any reagent prepared for casework
application. The record will indicate the prCpdret, the date of preparation, and the lot numbers, or
date of preparation, of components used in th ration of the new reagent.

3.2.8  Any visitors to the lab areas within Forensic Biology ﬁ equired to wear a mask and gloves
during their time spent in pre-amplification lab areas. Vi @ o lab areas will be asked to provide a

sample for the elimination database.

3.2.9  Analysts must wear appropriate personal protective equipment h}ﬂmining evidence. This
includes, at a minimum, a lab coat and gloves. Facemasks are recommer@

3.2.10 Prior to analysis, work areas must be cleaned with a 10-20% bleach solut eywork area will be
covered with clean paper or bench mats prior to evidence analysis. The con ms must be
inventoried and examined on a fresh piece of paper. This paper can be used to v{rapithe item after

examination.

3.2.11  After analysis, items will be returned to the original packaging. The package must be sealed with
evidence tape and the analyst must initial and date the seal. The barcode number must be on the
outer packaging. If the item cannot be returned to the original packaging, new packaging can be
created, but the original packaging must be packaged with the item.

3.2.12  Analysts must avoid compromising any information written on the evidence packaging. Notation
will be made in the case notes if the contents of the packaging could not be accessed without
breaking an existing evidence seal.
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3.2.13  Evidence collected from the suspect(s) must not be sampled or extracted at the same time as
evidence collected from the victim. Case scenario information relating to the locations evidence
items were collected must be considered so that evidence collected from locations associated with
the victim are not extracted with evidence from locations associated with the suspect. The DNA
extraction of evidence and reference samples must be separated by time and/or place.

en any time a sample/stain will be consumed for DNA testing.

3.2.14 4 The creation of microscope slides is mandatory for sexual assault evidence suspected of containing
S

in File_¢n-§ system, a notation as to final disposition will be made in the notes.

3.2.15 @ %gcr derivative evidence generated as a result of analysis will be assigned a new barcode

evidence trackifig dafabase regarding any additional associated barcodes created.

3.2.16 If an evidefic 'teI is swabbed for DNA analysis, a notation will be made within the File-on-Q

3.2.17 Scissors used for safnp evidence must be cleaned thoroughly with bleach, soap and water,
alcohol, or by flaming ezn sampling different stains. Alternatively, a fresh scalpel blade will be
le

used for each evidence sa

3.2.18 For any procedure performed is ensic Biology Unit only one tube or evidence item should
be open at a time during any samp agent/DNA addition. Use of any robotics system for
sample setup is an exception to this po

3.2.19 All reagents and solutions will be autoclaved Wwh ossible. Sterile water and sterile plastics or
glassware will be used for solutions that cannot be %ed.

s of any contamination events. The

O

3.2.21 Sterile disposable acrosol resistant pipette tips and sterile tubes %&ed for any processes
involved in DNA analysis. Pipette tips will be changed between a ding @oving liquid from

3.2.20 Reagents will be stored as small aliquots to minimize thq @

lot(s) of reagents used for each set of analyses will be rec

evidence sample tubes.

3.2.22 The DNA extraction/ purification of questioned samples will be performed s@ om the
DNA extraction/ purification of reference samples. In addition, it is advisable t A
extraction/purification of samples, where high amounts of DNA are expected, (references or large
bloodstains) be performed separately from samples where low amounts of DNA are expected
(single hairs or very small stains) to minimize the potential for sample to sample contamination.

3.2.23 At least one reagent blank will be employed for each set of DNA extractions/purifications to check
for possible contamination of the DNA extraction reagents. A reagent blank will be subjected to all
of the reagents and manipulations of the DNA analysis process as evidence samples. It is advisable to
employ multiple reagent blanks in a batch extraction to accommodate the combining of samples, or
the use of multiple DNA testing kits if any samples are consumed during a first analysis.
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3.2.24 Reagent blanks must be treated in the same manner as the most manipulated evidence sample
associated with it. The reagent blank will be carried through amplification and analysis with its
associated samples.

3.2.25 When performing manual PCR setup, DNA must be added to the tubes after all reagents
have been added. This practice reduces the possibility of inadvertent transfer of DNA between
samples and kit reagents. Only one sample tube should be open at a time during DNA addition.

3.2%1 disposable lab coats are to be used in the post-amplification area. Always remove gloves and
@ts before exiting the post-amplification area.

3.2.27 All su@ in the Amplification Area should be cleaned with 10-20% bleach solution before and

after settin mples for analysis.

3.2.28 All equipment @

unless proper det®

in the Amplification Area is dedicated to that area and will never be removed

t «@ ation procedures have been employed.

3.2.29 DNA interpretations mus% documented in the analytical record.

3.2.30 CODIS sheets for evidence sam&@t be part of the analytical record.
DNA SAMPLE STORAGE O

3.3.1 Short term storage of extracted DNA will be thﬁca d freezer in the PCR setup areca. DNA
extracts should be stored in closed containers or se e%.
3.3.2 Long-term storage of extracted DNA will be in the Prope@ . A new barcode number must

be created for extracted DNA samples. All new items in Fileg6n uire an incident number to
s%pl,

be assigned. Any new incident number assigned to extracted D es will follow the format

of: “ExtDNAanalystthreeletterinitiasMMDDYY”.

3.3.3 Storage of Amplified DNA samples will be in the dedicated freezer in thc%ion Area.

Under no circumstances will amplified DNA be stored outside the Amplification
&e date of

3.3.3.1 Amplified DNA samples will be maintained for a period of six months fr
amplification. After this time, the amplified DNA will be discarded.

POLICIES REGARDING FREEZER PACKETS

Freezer packets are created to store derivative evidence separated or prepared from other evidence that is

customarily stored unfrozen.
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Anytime a freezer packet is made for derivative evidence the following information (at minimum) should be

Clcarly markcd :

-Incident number or Case number (if available)

-Barcode number(s) of the evidence contained within

Any derjvative evidence (stains, cuttings, or swabs) that will be impounded into the Property Room as

addi al gvidence will require the generation of a new item in the barcode system under the appropriate

incide @r. Documentation of the newly generated items should be included in the case notes.

When items t@ad have a barcode number (or a sub-designation from an existing barcode number) are
packaged together, packaging is given a new barcode number for the purposes of storage, the

barcode of the packagin@ temporary storage purposes and does not become the designator for the items

2

3.5 UNIQUE IDENTIFIERS (

inside.

3.5.1 The barcode number will uniqu ify each item stored in the Property Room or Laboratory
Vault under the File-on-Q system. O

3.5.2  TItems stored under the old system will be @ identified by the case number (or lab sequence

number), property tag number, and item nu

3.5.3  Multiple items contained within a single package (c.g# the,contents of a SART kit) will all be given
a sub-item designations, which will be noted in the barcg @ tem for that item.

tracked back to the location from which they were sampled.

3.5.4  Any stains, cuttings, or swabs (i.c., derivative evidence) tak [ ems must be able to be

3.5.5  Derivative evidence that will be impounded into the Property Room Wi@re the generation of

anew item in the barcode system under the appropriate incident numbe i€n&wv barcode will
uniquely identify these pieces of derivative evidence.
C ing intcrnally

3.5.6  Allitems included on a laboratory request to be examined by the laboratory (ex
produced requests) are considered evidence.

3.5.7  All cell pellets, extracted DNA, and amplified DNA will be considered the work product of the
DNA laboratory.

3.5.8  Each sample analyzed within a batch will be labeled with an identifier that will uniquely identify it
during its analysis. Additional descriptors may be employed to identify particular samples, such as
“NS” to identify non-sperm fractions of extracts.
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3.6 DISCONTINUING ANALYSIS OF SAMPLES

3.6.1

3.6.2

3.6

3.6.4

3.6.5

Variables, such as the existence of other probative samples, or the case scenario may affect the
decision to discontinue the analysis of a sample.

Quantification information provides information into the likelihood of obtaining interpretable DNA
results, and the decision to discontinue analysis will be made after quantification of the sample(s).

inued.

i iamplc contains insufficient DNA to reasonably obtain an interpretable DNA profile, it will be

3.6.34" 1f 8pL of a sample are quantified AND the amount of total DNA in the extract is less than
or, to £0.0005ng/ L, and all controls indicate the quantification has performed as

expe E e samples are unlikely to yield interpretable DNA results with the GlobalFiler

ampli it and the sample will be discontinued.

3.6.3.1.1 Ana]ysts will consult with the DNA Technical Manager if they believe the control
results se them to doubt the reliability of the data from the quantification
assay.

3.6.3.1.2 Documented on from the DNA Technical Manager is required to amplify
samples for whic qation values >0.0005ng/ uL are obtained.

3.6.3.2 Samples that are expected to havéfa amount of DNA will have 8uL of extract
quantified.

In cases where multiple samples from the same item ected for the same purpose (e.g., DNA
sample collected from two different areas on a shirt for ¢) information), if one sample has

For sexual assault cases:

sufficient DNA additional samples collected for the same purp .@ ) ai be discontinued.

3.6.5.1 If the sperm fraction is probative, it should contain a detectabl€a of male DNA to
proceed with DNA analysis. If the sperm fraction is being typed, t@dated non-

sperm fraction can be discontinued.

3.6.5.2 If the non-sperm fraction is probative and male DNA is detected in the sperm fraction,
both the sperm and non-sperm fractions must be DNA typed.

3.6.5.3 If the non-sperm fraction is probative and no male DNA is detected in the sperm fraction,
only the non-sperm fraction needs to be DNA typed.

3.6.5.4 Ifno male DNA is detected in the sperm fraction and the non-sperm fraction has no male
DNA or a ratio of human:male DNA greater than 75:1, the analysis of both fractions can
be discontinued. In this situation YSTR testing may be performed if a suspect reference
sample is available.
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4.0 CODIS

The Combined DNA Index System (CODIS) is a nationwide forensic DNA database managed by the FBI. It consists
of DNA databases at the local (LDIS), state (SDIS), and national (NDIS) levels. The purpose of CODIS is to develop
investigative leads by matching DNA profiles of two or more samples from these various categories. The database
primarily consists of casework evidence profiles and convicted offender profiles. Sample categories include Forensic
Unknowns (single source profiles), Forensic Partials (single source, but partial profiles), Forensic Mixtures,

Convicted O eps, Arrestees, Suspects, Unidentified Human Remains, Missing Persons, and Relatives of Missing

Persons. O

The CODIS software segfches for genotypes that are represented by the list of alleles uploaded at each locus. Not all
genotypes represented by the Jistcd alleles may be accepted based on the interpretation of the evidence. For

example, if four alleles at a locus a#¢ Sybmitted to CODIS from a 2-person mixture, the search will return hits against

any homozygote genotype represt he listed alleles. Based on the interpretation of a 2-person mixture, any
homozygote genotype would be excldde

case analysts are responsible for determi in%at is being searched in CODIS in their assigned cases and what

5 a possible contributor, even though CODIS would return a hit to it. The

genotypes would be acceptable at each locu

Consultation with the CODIS Administrator for se of complex mixtures is encouraged. If the CODIS
Administrator is consulted, documentation of the consu ill be made on the CODIS sheet; however, the
technical reviewer is still mandated to assess the types and ¢ itself as being acceptable for CODIS. Technical

reviewers will document this review by initialing and dating the/CO sheet. Any material changes made to the
CODIS sheet as a result of the technical review must be documented)/Anyymaterial changes made by the CODIS
Administrator after technical review is complete must be discussed wi casOIyst and documented within the

analytical record.

4.0 ENTRY OF DNA PROFILES INTO CODIS l

4.0.1  The SDPD Forensic Biology Unit’s procedures for the entry of DNA profiles into CODIS will be
based upon the guidelines outlined in the NDIS Procedures and the Cali al Code.

4.0.2  DNA profiles selected for entry into CODIS will be documented in the technica
worksheets referred to as CODIS sheets. If multiple items from the same case ha

profile, only one CODIS sheet should be used.

on

the same DNA

4.0.3  CODIS sheets must be technically reviewed to ensure accuracy of the DNA types and specimen
category, and acceptability for CODIS entry.

4.0.4  Forensic mixture and forensic partial DNA records submitted to NDIS will be reviewed to ensure
the DNA records satisfy a statistical threshold for match rarity of approximately one in the size of
the NDIS database.
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4.0.5  DNA profiles (single source or mixtures) from possible perpetrators derived from evidence should
be entered into CODIS, unless that evidence was collected from a suspect.

4.0.6  DNA profiles or portions of DNA mixtures attributable solely to victims or elimination reference
samples (boyfriend, husband, etc.) will not be entered into CODIS.

4.0.7  Forensic profiles in CODIS that are ultimately linked to consensual partners will be removed from
the database.

4.0.8 @ S sheets will be filled out for qualifying suspect samples (see section 4.1) that were not
1 ’

;an evidence sample or that were included as possible contributors to a DNA mixture.

4.0.9  In gerferal, CQDIS sheets will be removed from the case file during the administrative review and
given to t IS Administrator for entry. Copies of CODIS sheets must be retained within the
technical recor @ mbered pages to document the CODIS search.

4.0.10 CODIS profiles wi@«iewed for eligibility, correct DNA types, and appropriate specimen
category prior to uplo fgal CODIS or beyond. This policy is not meant to prevent a keyboard

search of DNA profiles in¢the local CODIS database.

4.1 UPLOADING SUSPECT DNA PROFIIQ

4.1.1  DNA profiles from adult suspect samples apd % by the SDPD laboratory will be uploaded to the
local CODIS database if one of the following ¢ ns have been met.

4.1.1.2 They are subject to conditions associated with fourtQ atus,
le,

)

4.1.1.4 They have provided consent to the collection of their DNA by sign@PD Consent Form
acknowledging their DNA profile will be entered into the local CO dafaBase.

4.1.1.1 They have been arrested for a felony,

4.1.1.3 They are mandated by a court order to provide a DNA sa

4.1.2  Suspect DNA profiles will be maintained indefinitely within the local CODIS da@

4.1.3  DNA profiles previously uploaded to the State CODIS database will be removed from the State
level of CODIS and remain at the local level after the profile has been in State CODIS for a period
of two years.

4.1.4  Should a suspect with their profile entered into the State CODIS Database be eliminated as a
suspect in the case for which their sample was submitted, the DNA profile from that individual will
be removed from the State CODIS Database.
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No DNA profiles obtained from juveniles (i.c., under the age of 18 at the time of collection) will
be stored in the local CODIS database.

4.2 DATABASE SEARCHES AND MATCHES

4.2.1

Searches of the SDPD’s local DNA database can occur prior to technical review and are also

erformed by the state (California Department of Justice). Searches of the national database are

@rﬁjrmed at the time of the entry of the profile into CODIS. Searches of the state database are

4.2.2

4.2.3

4.2.4

4.2.5

d by the (FBI) laboratories. DNA profiles are uploaded to the state database at least once a
% ¢ with database searches and with the uploading of DNA profiles from state to

natlonal

Information& d within the SDPD’s local DNA database (SDPD’s LDIS) may be shared with

accredited foren A laboratories in other jurisdictions. Similarly, information from the LDIS of
accredited labor other jurisdictions may periodically be shared with our laboratory. In
these instances, a “ba containing the information within LDIS will be provided for the purpose

of comparing DNA profile 1nf mation between jurisdictions. When the SDPD Crime Laboratory

ith the SDPD’s LDIS and ownership of the data is retained by
the agency from which it originat e understanding of our laboratory that outside agencies

will take the same approach with ou @rmaﬂon.
There are two basic types of database matc ould provide an investigative lead: forensic hits

and offender hits. Forensic hits involve the mat unknown profiles from two cases. Offender

hits involve the matchlng of a Forensic Unknown to % ted Offender.

from the external agency is no

receives a batch file from a er agency, the batch file is used for a search against LDIS. The data
\ﬁd

Potential database matches at the State and National 1cvcls @ evaluated by the CODIS

Administrator (or designee).

Potential CODIS hits will be evaluated for “goodness of fit”. If thd po kl match is deemed to be
good, at that time the notification process will be allowed to proceed. Go@ of fit” of any

potential database match will be dependent on the specimen category.

4.2.5.1 Potential matches between forensic unknowns and any sample in a singlejo sample
index (e.g., convicted offender) can be assessed visually.

4.2.5.2 Potential matches between a mixture or partial DNA profile and any sample in a single
source sample index will be assessed through calculation of a likelihood ratio.

Note: The likelihood ratio will assess the probability of the evidence given the DNA profile
from the putative match is a component of the mixed or partial DNA profile searched against
the probability of the evidence given the DNA profile from the putative match is not in the
mixed or partial DNA profile searched.
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4.2.5.3 If a potential match is between a profile in the local suspect category and either a mixture, or
partial DNA profile, the local suspect profile must have the full complement of data for the
likelihood ratio comparison being reported (i.e., if the local suspect only has data at 15 lodi,
the reference sample must be tested for the full GlobalFiler dataset).

4.2.5.4 In general, the likelihood ratio results used for the assessment will be the lowest 99% 1-
sided HPD value for the four population groups.

.2.5.4.1 Potential associations to the database with likelihood ratio results greater than fifty times
O the size of the relevant database in these comparisons will be declared as offender or

}orcnsic hits.
4.2.5.4.2 For gemparisons with the local database, potential associations with likelihood ratio values

1 an the size of the local database will be disregarded.
4.2.5.4.3 Poten iations with State and National databases will be evaluated by the CODIS
Administrdto designee. Additional data may be requested from the jurisdiction with

which the pufative Jit has occurred to further evaluate its validity.

further reviewed to de if the putative associations will be reported.

4.2.5.4.4 Likelihood ratio re tgeen one and fifty times the size of the local database will be

4.2.5.4.5 Likelihood ratio results used s orensic and offender hits will be retained in the case
record, or electronically (G:\Mis \CODIS\CODIS Matches).

4.2.5.4.6 If the database LR results are sufficienﬂh .g., 1.0x10" or greater), it may not be
necessary to perform an LR with HPD cafculafioft as the value considering the HPD is
unlikely to be less than the likelihood ratio thre,

as a benchwork match. When an evidence sample has already be o0 a suspect and then

4.2.6 The matching of two evidence samples known or suspected to ¥e he same person is referred to
hn‘;ﬁ

matches the same person who is in the database as a Convicted Offenfler sample, this is referred to as
a conviction match.

4.2.7 Information regarding forensic and offender hits must be included in at least o Prior to a

match report being written, investigators may be contacted regarding DNA matc nfbrmation
must be communicated accurately. A communication of a database hit must be docuigented in a
communication log. Prior to releasing database hit information to an investigator, the results must be

reviewed by a second analyst and the review documented in the notes.

4.2.8 When likelihood ratios are calculated comparing any suspect profile from the local CODIS database
to any mixture or a partial evidence profiles, the suspect profile must have all the loci contained in the
evidence sample. This requirement applies even if the suspect reference was associated to a Forensic
Unknown (i.e., single source) component of a mixture.
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4.3 MAINTENANCE OF AN ELIMINATION DATABASE IN CODIS

Section 3.0 in the Quality Manual addresses this database. The following are the rules for the collection and

analysis of these samples:

4.3.1  The Quality Manager will coordinate sample collection of reference mouth swabs from the donors

and coding of the sample.

4.3$outh swab samples from donors to the elimination database will only be retained with permission

e donor.

4.3.3  Elimipdtion database samples will be analyzed by a qualified DNA analyst following the protocol
used to analy?cNeference mouth swabs in casework.

4.3.4 The DNA Tec
DNA profﬂcs in an

anager or CODIS Manager will review the analysis prior to entering the
@ ases used for comparisons to evidence.

4.3.5  Electropherograms will béintaincd for each sample.

4

4.4 REPORTING DNA RESULTS ASSOCI THE ELIMINATION DATABASE.

4.4.1  When an evidence DNA profile is found to or potentially be associated with a profile in the
climination DNA database, the following will be :

®  The CODIS match detail report, or first page of the %Ef Database Search report indicating the

association will be included in the analytical record.

= If the DNA profile in the case was found to match (or the mixt entially includes) DNA from
any elimination profile at an HPD LR value above 2 (i.e., limited s for inclusion or above), a
Quality Incident Summary form will be completed detailing the associatiop.

®  The Quality Incident Summary form will be submitted to the DNA Technic atlager, or
designee. Any associations with HPD values above 100 will be routed throu ity
Manager.

" Associations to the elimination database when the HPD LR is greater than 99 will be reflected in
the report.

O If the HPD LR value is greater than moderate support for inclusion (i.e., LR>10%), the analyst
will condition the evidence profile on the elimination sample. The report will list the
elimination sample as an assumed contributor.
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O If the LR value is in the moderate support for inclusion (i.e., 10’<LR<10*), the report will list
the elimination sample as having moderate support for inclusion.

4.5 OUTSOURCING

In order for the SDPD Crime Laboratory to accept outsourced data for the purposes of searching the CODIS
database%ﬁ)llowing criteria must be met prior to the initiation of analysis by the vendor laboratory:

accreditation, ng the vendor laboratory’s latest external audit report including responses and follow-

®  The vend @ orgtory selected for the analytical testing must be accredited and the documentation of that
f h
ded t

up must be prévi ghe SDPD Crime Laboratory.

®  Prior approval by Technical Manager of the technical specifications of any DNA analysis to be
performed by the vendq atory is required.

¢
®  An on-site visit to the Ve atory is required.

4.5.1 OWNERSHIP OF OUTSOURCED DATA

4.5.1.1 SDPD ownership of outsourﬁca ;ccurs when:

4.5.1.1.1 The SDPD will use anwsss , extracts, or materials from the vendor laboratory for
the purposes of forensic ic., a vendor laboratory prepares an extract that will
be analyzed by the SDPD lab );

4.5.1.1.2 The SDPD will interpret the da ted by the vendor laboratory;

4.5.1.1.3 The SDPD laboratory will issue a repgrt o, the results of the analysis; or

4.5.1.1.4  The SDPD will enter or search a DNA & in CODIS from data generated by the

vendor laboratory. O

4.5.1.2 The SDPD will not take ownership of any cases deemed “negdatiye: !egative cases are those that:

4.5.1.2.1 Are negative during initial screening;
4.5.1.2.2  Are determined to have quantities of DNA unsuitable for @ml STR analysis; or
4.5.1.2.3 Yield DNA profiles consistent with originating from the re a

xpected donor of
the item, consensual partners, or witnesses. &

4.5.2  ON-SITE VISITS TO VENDOR LABORATORIES

4.5.2.1 Prior to the initiation of testing in an outsourcing agreement, an on-site visit of the vendor
laboratory must be documented.

4.5.2.1.1 The on-site visit of the vendor laboratory must be conducted by the DNA Technical
Manager, or another qualified (or previously qualified) analyst designated by the DNA
Technical Manager, or Supervising Criminalist.

4.5.2.1.2  An on-site visit performed by the technical leader, or designated employee of an NDIS
laboratory that uses the same technology, platform, and typing amplification test kit
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may be accepted by the DNA Technical Manager in lieu of performing the on-site visit
outlined in 4.5.2.1.1.
4.5.2.2 An on-site visit to a vendor laboratory will include at a minimum:

4.5.2.2.1 An evaluation of the laboratory facilities to ensure the integrity of the evidence will be
maintained while in the custody of the vendor lab.

contamination of the evidence while in the custody of the vendor lab.

4.5.2.2.2 An evaluation of the procedures as they relate to ensuring minimal loss or
%2.3 An evaluation of any Corrective Actions taken by the laboratory in the previous six
2

months prior to the on-site visit.
4.5. »ﬁn interview with the vendor laboratory’s DNA Technical Manager or laboratory
a

st.
4.5.2.3 The on-site Vi@ be documented and maintained by the DNA Technical Manager.

4.5.2.4 If an outsourcing agfe t with a vendor lab is extended beyond one year, annual on-site visits to
the vendor laboratory fmust b€ documented.

4.5.2.4.1 As described in #5% 4.2 an on-site visit conducted by another NDIS participating
laboratory, or FBI defi employee may be accepted by the DNA Technical
Manager.
4.5.3 QUALITY CONTROL OF OUTSOUR TA
4.5.3.1 Complete technical review will be conducted 4‘0 imately 3% of “negative cases” as defined in
4.5.1.2.
4.5.3.2 The SDPD Laboratory will conduct retesting on approxi 6 of all outsourced cases to

ensure the accuracy of the testing results reported by the ve atory. If a case selected for
retesting had a searchable DNA profile obtained, but retesting o%uire the consumption of
the original evidence, then a new case will be selected for retestind’so as ngt to consume the
original evidence. It is permissible to consume original evidence for any@e cases selected for
retesting.

4.5.4 OUTSOURCED DATA %

4.5.4.1 A technical review of the outsourced data will be performed prior to uploading any DNA profiles
to SDIS (or NDIS).

4.5.4.2 The technical review of the outsourced data will be performed by an analyst:
4.5.4.2.1 Thatis, or was previously, qualified in the technology, platform, and typing
amplification kit used to generate the data;

4.5.4.2.2  That participates in the SDPD external proficiency test program to the full extent they
participate in casework and the review of outsourced data;
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4.5.4.3 The technical review of the outsourced data will include a review of:

4.5.4.3.1 All DNA types to verify that they are supported by the raw and/or analyzed data;

4.5.4.3.2 All associated controls, internal lane standard and allelic ladders to verify the expected
results were obtained;

4.5.4.3.3 The final report to verify the results and conclusions are supported by the data, and that

each item tested has been addressed.
%.4.3.4 The DNA types, eligibility, and correct specimen category of any profile to be uploaded

into CODIS.

4544 A ref;o»ll be issued by the Forensic Biology Unit for any outsourced case in which a DNA
profil€is %archcd in CODIS. The report will indicate the extent of the database search (i.e.,

local, Stat ational).

4.6 REINTERPRETATION ACY AMPLIFICATION KIT DATA

According to the FBI Director’s Qualit Standards for DNA Testing Laboratories standard 13 states, an

analyst can only interpret data generated am hﬁcatlon test kit in which he or she is currently proficiency
tested, therefore if the analyst is not currentl ' ency tested in an amplification test kit previously used by

the laboratory (i.c., a legacy amplification klt) ‘cannot reinterpret the legacy data.

This policy is intended for situations when an analyst is to reinterpret data generated with legacy

use.

amplification test kits for a comparison made to DNA profl }edwﬁh amplification test kits in current

Reinterpretation of legacy data may occur in accordance with the follc@

1. Ifan analyst is currently qualified in an amplification test kit (trainfld and proficiency tested), and the
analyst was previously qualified (trained and proficiency tested) in thgflegacy amplification test kit,
the analyst can reinterpret the legacy data if the analyst has been proficiencyfested on the legacy test

kit within the last two calendar years. If an analyst has not been proficiency te a legacy test kit
within the last two calendar years, then the Technical Leader must document rove the
completion of the analyst’s review of the validation data and standard operating s of the

legacy test kit. If an analyst, who has completed the requirements to interpret legacyamplification
test kit data, has not reviewed the required documents within the last two calendar years, the
Technical Leader must document and approve the completion of the analyst’s additional review.

2. Ifan analyst is currently qualified in an amplification test kit (trained and proficiency tested), but has
never been previously qualified in the legacy amplification test kit, the analyst can reinterpret the
legacy amplification test kit data if the analyst is trained in the legacy test kit interpretation protocols
by a previously qualified analyst. The review of the validation data and standard operating procedures
of the legacy test kit, training by the previously qualified analyst, and interpretation competency test
must be completed by the analyst, and documented and approved by the Technical Leader.
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Documentation shall contain sufficient information for an auditor to confirm the analyst is qualified to
reinterpret legacy amplification test kit data.

3. Ifapreviously qualified analyst is unavailable to train a currently qualified analyst on a legacy
amplification test kit, it is highly recommended that the current analyst not reinterpret legacy data.
However, if the current analyst must perform legacy interpretation without training from a
previously qualified analyst, then it is recommended that the currently qualified analyst and Technical

cader train in the legacy test kit interpretation protocols, review validation data and standard
dpepating procedures. The training and interpretation competency test must be completed by the
and documented and approved by the Technical Leader. Documentation shall contain
igformation for an auditor to confirm the analyst is qualified to reinterpret legacy
amplificatiénvest kit data.

4. Ifa laborato@rates new interpretation protocols from legacy validation data (e.g., developing a

stochastic thresh n none previously existed), the laboratory shall document the basis for the
new interpretati ls. These new protocols shall be documented in the laboratory’s standard
operating proceduresén morialized in the Quality Assurance Standards Audit Document. The

training and interpretatign copppetency test must also be completed by the analyst, and documented

Leader. Documentation shall contain sufficient information for an

and approved by the Techni

auditor to confirm the analyst fied to reinterpret legacy amplification test kit data.

Technical reviewers of reinterpretations of the @are held to the same training requirements as the

analyst reinterpreting the data.
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5.0 LABORATORY MAINTENANCE

5.0 GENERAL LABORATORY MAINTENANCE

All members of the Forensic Biology Unit are responsible for the general upkeep of the laboratory including
stocking supplies, and cleaning common areas. Protective gloves and a laboratory coat should be worn when
cleaning the laboratory or instruments. The following maintenance and cleaning policies are in addition to the
cleaning reggired by analysts prior to and after using any bench area or instrument for analysis.

WEEKLY

®  Monitor the opgfating temperatures of all freezers, refrigerators, and incubators. Log temperatures on the
log sheets attached to umentation. When a sheet has been completed, it should be scanned into the FB
ppropriate folder within the QA-QC folder. The scanned sheet should be saved

dicates what instrument the log is for and what time period it covers.

network and moved
using a file name that cl

e  Fill distilled water carboys, reagent algohol bottles, 10-20% bleach solution bottles, and Liquinox detergent
bottles. (

®  Wash glassware and dishes. Return W&SS@S to their appropriate storage location.
5.0.1 Glassware Washing O

Protective gloves and a lab coat or apron should be worh.
1. Wash glassware in warm water with Liquinox detergent. }

0,

3. Rinse each piece of glassware in distilled water. F

4. Set glassware to dry. %
5. Return glassware to appropriate storage location when dry. @

MONTHLY DUTIES

2. Rinse detergent from glassware by rinsing in tap water.

® Restock and organize supplies and workstations.
®  Wipe counters with 10-20% bleach solution.

®  Wipe/dust all instrument exteriors with ethanol.
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® (Clean centrifuges with 10-20% bleach solution followed by distilled water.
®  Wipe inside of hoods with 10-20% bleach solution and plastic/exterior surfaces with ethanol.
®  Clean interior and exterior of drying boxes with 10-20% bleach solution.

®  Wipe/dust all shelving units.

e Wash and tip holders, QiaCube tip waste drawer inserts, and QiaSymphony sample and elution

racks. }

e Vacuum floors (excﬁt—ampliﬁcation room floor).

®  Mop (or Swiffer) the ﬂc%020% bleach.

®  (Clean sinks.

Record the completion of cleaning tasksi(v%ly Cleaning Worksheets and submit them for scanning in

the Maintenance Logs.

5.1 MAINTENANCE LOGS O
The following cleaning logs will be maintained by the Forenﬂo Unit. They are intended to ensure
laboratory areas are kept in a clean state. Any cleaning should e%l electronically into the FB cleaning log

excel workbook. O

Cleaning Logs Location F q#ncy
Front extraction area with microscopes Electronic Mon ly /
Main extraction/purification Electronic Monthly V(\

PCR Setup and Post-Amplification Electronic Monthly 0&

5.2 DISPOSAL OF HAZARDOUS WASTE

There are six waste streams within the Forensic Biology Unit that should be handled as hazardous waste.

These are as follows:

5.2.1 PHENOLPHTHALIN CONTAMINATED SWABS
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Phenolphthalin contains ethanol and swabs contaminated with it will go into appropriately
labeled waste buckets. After the swabs have dried the swabs can be disposed of in the

regular trash.

PHENOLPHTHALIN AND LMG LIQUID WASTE
Phenolphthalin and LMG liquid waste contains zinc; a heavy metal. The unusable liquid

waste will be stored in the Chemical Storeroom for disposal. The bottles should be
piopriately labeled with the hazard (flammable for pheno and corrosive for LMG). The
tained in both reagents should also be noted on the log.

QIAGEN/REAGENT WASTE (EZ1 or QiaSymphony)
EZ1 strips are mable because of the ethanol they contain and should be placed in the

designated wast ners by the instruments. All tips, tip holders, and tubes can be

disposed of as reg grash. When the EZ1 strip waste containers are full the waste can be
transferred to the € Storeroom for disposal. Liquid QiaSymphony waste can also be
transferred to the Chemildl Storeroom.

FORMAMIDE WASTE
Formamide is a known teratogen ormamide waste will be disposed of in the waste

bucket in the amplification room. if the waste can be transferred to the Chemical

Storeroom for disposal.

BIOHAZARDOUS WASTE
Large volumes of liquid blood are biohazardous. "An¥lardg volumes of blood and the

materials used to clean them up should be disposed of ipfred biohazard containers.

NON-HAZARDOUS WASTE @

Small volumes of blood that will dry within a reasonable amount gf tinje can be disposed of in the
regular trash. LMG test swabs can be disposed of in the regular tras%plasticware (e.g., tips,
tubes, transfer pipets, etc.) and gloves can be disposed of in the regular tragh. Acid phosphatase test

DS

swabs can be disposed of in the regular trash and any waste liquid down th
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6.0 EQUIPMENT MAINTENANCE PROTOCOLS
6.0 USE AND MAINTENANCE OF THE WATER SYSTEM
The ultra/nano pure system uses the distilled water reservoir as its water source.

Ultra pure water

steag NANOpure ultra pure water system removes ions from water. It is meant to be used with

Lons

through the cartrigGes for five minutes out of every hour. This extends the life of the cartridges. When ultra

pretreatad Hence, the water used is first distilled. The system can be set to three different modes: off,

standby, an system is left on standby when not actively in use to allow water to be circulated

pure water is needed, system to the on mode by pressing the ‘ON/STANDBY/OFF’ button until a
numerical value appears. umber represents a resistivity measurement of the water, which indicates its
purity. Wait for the num case to at least 18.0 before dispensing. If this number remains below
18.0, then the cartridge is no fficiently deionizing the water. A carboy is used to collect and store

never be used when the distilled wat

ultra pure water, as the system p dlzpurified water rather slowly. The ultra pure water system should
r

eserypir is empty. A low water protection device has been built into
the distilled water reservoir to prevent %re water system from operating when the still is low.

6.1 OPERATION OF THE pH METER O

Thermo Scientific Orion Star A111 pH Meter Operation 4}

Electrode Preparation

1. Disconnect electrode from meter.

2. Uncover the filling hole and add electrode filling Ag/AgCl solution.

3. Solution must be above reference junction and at least one inch above sa p%\.

4. The filling hole must be open when electrode is in use and closed when in storage.

5. Place the electrode in the electrode holder and suspend it in air for 5 minutes so @ solution in the

electrode can thoroughly wet the reference junction.

N o

Soak electrode in pH electrode storage solution for 30 to 60 minutes.
8. Connect electrode to meter.

Shake electrode downward (similar to a thermometer) to remove air bubbles. %

Electrode Storage

1. Short-term Storage (up to one week)
a.  Soak the electrode in pH electrode storage solution.

b. To prevent crystallization of the fill solution, cover the fill hole whenever the electrode is being stored and
open the fill hole when calibrating and measuring.

2. Long-term Storage (more than one week)
a.  Fill the reference chamber and securely cover the filling hole.

K Forensic Biology Unit Policy Manual v11-25-2019 Page 42 of 82




-

Unit Policy Manual

Forensic Biology

b.  Cover the sensing element and reference junction with the protective cap/sleeve containing a few drops
of storage solution.
c.  Before returning the electrode to use, prepare it as a new electrode.

Electrode Maintenance

1. Inspect the electrode for scratches, cracks, salt crystals.

2. Rinse off salt crystals with DI water.

3. Drain the reference chamber, flush it with fresh filling solution and refill the chamber with fresh filling
soluti

Electrode Cle @
—

1. Soak electro@ M HCL or HNO3 for 30 min.
a. Can also bt soakegain a 1:10 dilution of household bleach mixed with hot water (stir at fast rate).
2. Drain the referencﬁer and refill it with fresh filling solution.

3. Soak the electrode in p @ ode storage solution for at least 1 hour.

Calibration

1. Prepare the electrode according to electrode preparation instructions.
2. Connect the probe to the meter angurn on the meter.

3. Press mode to display pH for the p 41"0 ent mode.

4. Select 2 pH buffers that bracket the pH y, rgeting.

5. Press Cal ‘

6. Rinse the electrode in DI water and blot with a@i

7. Place electrode into first buffer.

8. Wait for “Ready” then record value in log book.

9. Rinse the electrode in DI water and blot with a kim wipﬁ

—_
=]

. Place electrode into second buffer.

11. Wait for “Ready” then record value in log book. }
12. Rinse the electrode in DI water and blot with a kim wipe.
Measurement F

1. Perform Calibration steps first.

2. Make sure it is in pH measurement mode. O
3. Press measure: the meter will immediately start taking readings.
4. When “Ready” is displayed the meter stops measuring the pH, so you may need to fire sure

multiple times when pH-ing the solution.
5. When you reach the target pH rinse the electrode in DI water and blot with a kim wipe.
6. Turn pH meter off.
Store electrode according to the Electrode Storage directions provided.

6.2 OPERATION OF THE AUTOCLAVE

The autoclave is used to sterilize critical reagents and equipment via steam pressurization. There are two exhaust
selector settings on the autoclave: FAST (Instruments) and SLOW (Liquids). Use the slow setting when only

liquids or liquids and equipment are being sterilized. If sterilizing equipment use the fast setting.
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1. Close the drain valve.

2. Fill with autoclave with approximately 5.5 liters distilled water and 0.5 liters tap water.

3. Load autoclave with items to be sterilized. Place autoclave tape on lids, if necessary, and be sure lids are on
loosely.

4. Close autoclave door. Be sure the door closes tightly. If not, adjust the screw below the door handle latch.

5. Set the exhaust selector to “Fast or Slow”, depending on the items being sterilized.

6.

7.

Set the gime for 30 minutes.
Wh egterilization is complete, carefully open the door and drain valve. Do not open the autoclave
e

@er sterilization is complete due to the high heat and pressure; allow to cool and depressurize.

6.3 BALANCES /<\

6.3.1  Laboratory bali 1 be calibrated and verified by an outside company once a year.

6.4 MAINTENANCE OF THE GEN EZ1s

imm

Each month the piercing units will be cl d the O-rings greased on the Qiagen EZ1 robots. Maintenance
actions will be recorded on the Qiagen EZ1 ce Worksheet. A volume test will be conducted every six
he

months to monitor the pipetting accuracy of t ob esults of the volume test are recorded on the
BioRobot EZ1 Volume Test Worksheet.

6.4.1  CLEANING THE PIERCING UNIT: i,y

The piercing unit cleaning protocol can be accessed using either Investigator Card or the Volume
d

Test Card. If only a cleaning is required, use the DNA Investigator ifsa volume test is also due, then use

the Volume Test card. This will limit the number of times the machine4 on and off and cards are
switched. Never remove or insert a card when the machine is on.{ Th A Investigator Card

should always be in the machine so that it ready for use.

1.  With the robot off, insert the Volume Test Card or ensure that the DNA Investigat@d is in the card
slot.

2.  With the door closed, turn the machine on.

3. Press 1. Protocols.

4. Press 3. Clean piercing unit. The piercing unit will move forward and downward.
5. Open the door by lifting up, and clean the piercing unit with reagent alcohol.

6. Close the door and press Esc when finished.
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6.4.2  GREASING THE O-RINGS:

Apply a small amount of silicon grease to the top of a filter tip and use it to apply the grease to the tip adapters.

Wipe off any excess grease with a tissue.

6.4.3 VOLUME TEST:

The volu equires the use of the Volume Test Card.

1. With the m%{urned off, insert the Volume Test Card.

weight of the empty ¢

2. For each robot t@ ed, individually number and weigh six empty elution tubes with caps. Record the
i) tubes on the BioRobot EZ1 Volume Test Worksheet in the Qiagen EZ1

Maintenance Log.

3. Place the six empty elution tube%thout their caps, in row 1.

4. Place six sample tubes containing 1mL ; @led water in row 4.

5. Place six tips in tip holders in row 2.

6. With the door closed, turn the machine on. i 7
7. Press the Start button. The volume test will begin. }

8. When the test is complete, press Esc to exit the protocol and t chine off.
9. Remove the Volume Test Card and insert the DNA Investigator Card. F
10. Replace the caps on the elution tubes and remove them from the machine. O

11. Weigh each tube, now filled with approximately 500 uL of distilled water. &9@

Record the weights of the water on the Volume Test Worksheet and calculate the variance. Allowable
variance is within 5% of the volume pipetted. For the 500uL pipetted in the volume test, the allowable range
is 474 to 525 pL. Recall that 500uL is equal to 500mg.

6.5 HAMILTON NIMBUS 4 MAINTENANCE
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The Nimbus requires routine maintenance to be performed daily, weekly, and semi-annually in order to ensure
optimal performance. Any maintenance failures should be reported to Hamilton Technical Support (1-800-648-
5950) for troubleshooting assistance.

Daily Maintenance:

The daily maintenance should be performed prior to the first run of the day. It is not necessary to perform the
daily maintepance prior to subsequent runs if it has already been performed on a given day. It is also not

necessar pesform the daily maintenance on days the Nimbus is not used.

1. Power Ol@%ls instrument and attached computer.

2. Open the Maintenanﬁtware (on the desktop).

3. Select the “Daily” maine pe and click “Run Maintenance”.

4. Inspect deck and carriers for clganlinegs.
a. Clean the deck with deionizedéer and/or ethanol.
b.  Wipe the o-rings on the channe ith/deionized water.
c.  Check the “Inspect deck and caryle cleanliness” box.

5. Empty Tip Waste/Liquid Waste.
a. Remove the tip waste receptacle and empty tipsg ash.
b. Replace plastic trash bag in tip waste receptacle if ed7

c.  There is no liquid waste to empty.

d.  Check the “Empty Tip Waste/Liquid Waste” box. }

6. Sclect the “Check tightness of Pipetting Channels” box. O
a. Read the message that appears, remove the tip eject plate, close e and click “Continue”.
IS. F

b. The system will automatically test the o-ring seals of the channe

7. Select the “Check LLD” box. Q
a. Read the message that appears, ensure the tip eject plate is still removed and s still closed, and
click “Continue”.
b.  The system will automatically test liquid level sensing.
8. Click “OK” to acknowledge that the maintenance has completed successfully.
9. Replace the tip eject plate.

10. Click “Close”.

11. Exit the Maintenance software.
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Weekly Maintenance:

The weekly maintenance should be performed once a week regardless of whether or not the Nimbus is to be

used that week.

1. Power on the Nimbus instrument and attached computer.

2. Opepftlic Maintenance software (on the desktop).
3. Select th@ ” maintenance type and click “Run Maintenance”.

4. Clean deck and carrie

a. Clean the deckéwi eionized water and/or ethanol.
b. Check the “Clean nd carriers” box.

5. Check condition of carriers @er devices.
a. Visually inspect the instrument f6r any obvious signs of damage.
b. Clean the pedestals and racks With

ith waser and/or ethanol.
c. Check the “Check condition 04‘i§ and other devices” box.

6. Empty and clean Tip Waste/Liquid Waste. Q

a. Remove the tip waste receptacle and empt trash.
Replace plastic trash bag in tip waste rcccptad@cd.
There is no liquid waste to empty.
Clean the tip eject plate with deionized water and/or e¢than

Check the “Empty and clean Tip Waste/Liquid W e”O

o ao T

7. Clean each channel: stop disk, o-ring, and tip eject sleeve.

a.  Wipe the pipettor channels with a kimwipe dampened with deionizefl wafer.
b.  Check the “Clean each channel: stop disk, o-ring, and tip ejecfsieceve” box.

8. Clean the side covers
a. Clean the Nimbus enclosure with deionized water and/or ethanol. @
b. Check the “Clean the side covers” box. &

9. Select the “Check tightness of Pipette Channels” box.
a. Read the message that appears, remove the tip eject plate, close the door, and click “Continue”.
b.  The system will automatically test the o-ring seals of the channels.

10. Select the “Check cLLD” box.
a. Read the message that appears, ensure the tip eject plate is still removed and the door is still closed, and
click “Continue”.
b.  The system will automatically test liquid level sensing.
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11. Click “OK” to acknowledge that the maintenance has completed successfully.
12. Replace the tip eject plate.
13. Click “Close”.

14. Exit the Maintenance software.

At least once a

ra%ice engineer from Hamilton will perform maintenance and calibration of the Nimbus.
REFERENCES: /0

Microlab® Nimbus Independe 1 Operator’s Manual. Hamilton Robotics.

Microlab® Nimbus Independent Chann, rogrammer’s Manual. Hamilton Robotics.

Microlab® Nimbus Enclosed Versio per;tor’s Manual. Hamilton Robotics.

6.6 QIACUBE MAINTENANCE @

6.6.1 MONTHLY MAINTENANCE O

column lid holder, by carefully wiping these modules*withfa sbft lint-free cloth moistened with water. To
gain access to the modules within the robotic arm:

1. Clean the optical sensor, tip adapter, gripper unit, i W the gripper, the stabilizing rod, and the spin

a. Press “Tools” in the main menu.
b.  Select “Maintenance” by pressing the up/down arrows rough the list until it is

highlighted, and then press “Select”.
c. Select “Cleaning position” by pressing the up/down arrows to cm%bough the list until it is

highlighted, and then press “Start”.
d. Follow the instructions displayed in the touchscreen. You will be instr@) remove the waste

drawer and the labware tray.

The robotic arm will move forward and downwards, enabling the modules to be aﬁ%ﬂeaning

through the opening for the waste drawer.

2. After cleaning the modules of the robotic arm, switch off the QiaCube at the power switch.

3. Thoroughly wipe the worktable with a soft lint-free cloth moistened with cleaning agent. Incubate as
appropriate, rinse with distilled water, and wipe dry with paper towels.

4. Clean the shaker rack, labware tray, heating adapter, and reagent bottle rack with cleaning agent. Incubate
as appropriate, rinse thoroughly with distilled water, and wipe dry with paper towels.

\ Forensic Biology Unit Policy Manual v11-25-2019 Page 48 of 82 /




-

Unit Policy Manual

Forensic Biology

5. Clean the liner of the waste drawer with cleaning agent. Incubate as appropriate, rinse with distilled
water, and wipe dry with paper towels.

6. Thoroughly wipe the inside and outside of the QiaCube using the cleaning agents.

Important: Do not use alcohol or alcohol-based disinfectants to decontaminate the QiaCube door.

Importapd] Take care that no liquid runs down the touchscreen. Liquid may be drawn through the dust
protectio a“ii by capillary forces and cause malfunction of the display. To clean the touchscreen, moisten a

soft lint-fre with 70% ethanol or a mild disinfectant and carefully wipe the display. Wipe dry with a

paper towel.

6.6.2 SEMI—ANMAINTENANCE

The centrifuge lid must be low access to the inside of the centrifuge. The lid should be opened only
after the centrifuge has come {0 a plete stop. If the lid does not open automatically, perform the following

steps.

1. Press “Tools” in the main menu.(ﬁ
2. Highlight “Maintenance” (scroll through té sing the up/down arrows), and press “Select”.
@he up/down arrows), and press “Select”.

3. Highlight “Open lid” (scroll through the list by préss

Cleaning the rotor and buckets ; }

1. Switch off the QIAcube at the power switch. O

2. Remove used disposable labware, sample tubes, and reagents from th$or£tahle. Discard according to

your local safety regulations.

3. Close the buffer bottles tightly, and store according to the instructions in the r%handbook.

5. Remove the buckets from the rotor. Undo the rotor nut on top of the rotor using the rotor key, and
carefully lift the rotor off the rotor shaft.

4. Remove all disposable rotor adapters, including tubes and spin columns, from the bu

6. Submerge the rotor, buckets, and rotor nut in cleaning agent. Incubate as appropriate.

7. Rinse thoroughly with distilled water. Use a brush (i.e., a toothbrush or tube brush) to clean any parts
that are difficult to access, such as the bucket mount and the rotor head. Wipe surfaces dry with a soft lint-
free cloth. If available, dry the buckets and rotor with pressurized air.
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Important: Make sure the paper towels and brush used are lint-free.
Important: Make sure that all residual salt is removed.

Important: Make sure to remove all traces of cleaning agent from the centrifuge buckets. Residual agent
can cause the buckets to jam.

8. Applya few drops of mineral oil (Anti-Corrosion Oil (rotor), cat. no. 901854 3) on a soft, lint-free cloth,
a ipg the bucket mount and rotor claw. A thin, invisible oil film should cover the bucket mount and

roto Qut no droplets or smear should be apparent.
9. Apply oil'to %tor claw and to the bucket mount.
Important: Before ap@il to the rotor buckets on the rotor, make sure that the rotor and all buckets are
completely dry.

Cleaning the centrifuge

1. Moisten a soft lint-free cloth Wi‘éamiig agent, and clean the inside of the centrifuge and the centrifuge

gasket. Incubate as appropriate.

2. Clean the inside of the centrifuge and th ith distilled water, and wipe dry with lint-free paper
towels. If available, use a vacuum cleaner.

Important: Make sure the gaskets remain in the proper p %
d

3. Clean the centrifuge lid with a soft lint-free cloth moisterie cleaning agent. Incubate as appropriate,

clean with water, and wipe dry with paper towels. O

Technical Services.

4. Check the centrifuge gasket for damage. If the gasket is damaged or sEns of wear, contact QIAGEN

Installing the centrifuge rotor and buckets O

1. Mount the rotor. The rotor can be mounted in only one orientation. The pin on th rogor ghaft fits into a
notch on the underside of the rotor directly underneath rotor position 1. Line up positi of the rotor
with the pin on the rotor shaft and carefully lower the rotor onto the shaft. Install the rotqr nut on top of
the rotor and tighten using the rotor key supplied with the QIAcube. Make sure that the rotor is securely
seated.

2. Replace the rotor buckets. When replacing the rotor buckets, the side of the rotor bucket that must face
toward the rotor shaft is marked with a gray line. Hold the bucket at an angle with the gray line facing the
center of the rotor and hang the bucket on the rotor. Check that all buckets are properly suspended and
can swing freely.

Important: All centrifuge buckets must be mounted before starting a run.
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Tightness Test

The tightness test is performed to check whether the tightness of the pipetting system, including the attached

pipetting tip, is sufficient.

1.

10.

11.

Load an empty 2 ml safe- lock microcentrifuge tube in position 1 of the shaker.

Filldreagent bottle with 96% ethanol and place in position 1 of the reagent bottle rack.

Loa ahe filter tips you want to test (1000 ul or 1000 pl wide-bore) onto the QIAcube.
Make sure that tl%/\cube is switched on.

In the main menu, pr ols”.

Select “Maintenance” by p@ the up/down buttons to scroll through the list until it is highlighted, and

then press “Select”.

Select “Tightness test” by pressing down buttons to scroll through the list until it is highlighted,
and then press “Select”.

Select the appropriate type of filter-tips (“lO@p " or “1000 Ul wide-bore tips”) by pressing the
up/down buttons to scroll through the list untiit j lighted, and then press “Select”.

Press “Start” to start the tightness test with the selectﬁ ilter-tips.

Follow the instructions displayed in the touchscreen, and press ‘” to start the tightness test. After the
load check, the robotic arm will pick up a tip, aspirate ethanol,and

in place above the tube for 2 minutes. The tip will be detached.
eflube

to the tube. The tip will remain

After the protocol is completed, open the QIAcube door and check if th contains liquid. If the tube
is still empty and dry, the tightness of the pipetting system is adequate. If you fjfd liguid in the tube,
contact QIAGEN Technical Services.

6.6.3 ANNUAL MAINTENANCE &9@

A Qiagen Service Engineer will perform maintenance on an annual basis.

6.7 QIASYMPHONY MAINTENANCE

6.7.1 DAILY MAINTENANCE

After every day in which the QiaSymphony is run:
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Tip Disposal Chute

1. Remove, clean, and rinse the tip disposal chute. Ensure it is dry before reinstalling.

Liquid Waste Container

1. Remove and empty the liquid waste container into the waste barrel for EZ1 reagents.

2. C@w‘ rinse the liquid waste container.

3. Replac d Waste container. Note: the liquid waste container can be autoclaved (121°C for 20min).

Drawers and lysis staf1

1. Remove all removablts (tube/plate carriers, adapters, inserts, liquid waste station/tip park station,
tip disposal chute, liquid ottle) from the drawers.

2. Wipe the drawers and the refnovedfobjects as well as the lysis station with ethanol-based disinfectant and
incubate as appropriate. Then wige W cloth moistened with water and dry with paper towels. Return

the objects to the drawers.

3. Optional: Clean the removed objects by&@m in a glyoxal and quaternary ammonium salt based

disinfectant (e.g., Lysetol AF).

<

Important: There are spikes below the piercing device in agents and Consumables” drawer that ensure

that the reagent cartridge is correctly positioned. Take care wiien ning the “Reagents and Consumables”

drawer.
Robotic Gripper O
noib

1. Wipe the robotic gripper with a lint-free cloth moistened with etha %&infectant. Incubate as
appropriate. Important: Only wipe the weight. Do not wipe the rods oth rwis@all mechanism may
become jammed.

2. Wipe with a lint-free cloth moistened with water and dry with paper towels.

WEEKLY MAINTENANCE @
In every week in which the QiaSymphony is run:

Drawers and Lysis Station

1. Remove tube/plate carriers, adapters, and inserts and soak them in disinfectant (e.g., Lysetol AF).
Incubate for at least 15 min, then rinse with water and dry with paper towels.
2. Check the condition of the bar code labels and make sure that they are not scratched.
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Touch Screen

Wipe the touch screen with ethanol-based disinfectant and incubate as appropriate. Then wipe with a cloth

moistened with water and dry with paper towels.
QiaSymphony Hood

Wipe ch with a soft lint-free cloth moistened with deionized water. Then dry with a dry soft lintfree

cloth or Cvel. Important: Do not use ethanol-based disinfectant.
Pipetting Sys %d Guards
1. Remove all 4 tip@

2. Soakina glyoxal and

ary ammonium salt based disinfectant (e.g., Lysetol AF) for at least 15 min.
3. Rinse with water and W ith paper towels. Make sure to replace the tip guards before operating

the instrument.

O—Ring Tightness Test (

The tightness of the tip adapter O-ring sho ecked weekly and the O-ring must be changed monthly.

1. In the “Tools” screen, press “Service SP” or “@ ”. Then select the service script
“CheckPipettingChannel ORing.lua”.

2. Press “Start” to start the tightness test.

3. Follow the instructions in the messages displayed on the tHuchshreen. When instructed to do so by the
software, place an empty tip-rack containing 4 test tips intoﬁ nrack slot shown in the software
message (see picture on next page). Note: Do not start an inve’can during the protocol run. When
the inventory scan message appears, press “No, nothing changed®

4. If after running the tightness test for a particular tip adapter a messdge 18"displayed with “Failed”, the O-
ring must be changed. If one tip adapter fails the tightness test, we rec m;l?changing all 4 O-rings at

the same time.

6.7.2 MONTHLY MAINTENANCE O

Magnetic Head @

Remove the cover from the magnetic head.

2. Wipe the exterior of the magnetic head with a lint-free cloth moistened with ethanol-based disinfectant
and incubate as appropriate.

3. Wipe with a lint-free cloth moistened with water and dry with paper towels.

Magnetic Head Guards

1. Check the magnetic-head guards. If required, clean before starting the next protocol run.
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2. Open the “Maintenance” menu and run the service protocol “MH guard”. Gently raise the catches to
release the magnetic-head guards.

3. Wipe the magnetic-head guards with ethanol-based disinfectant and incubate as appropriate.
Wipe with a lint-free cloth moistened with water and wipe dry with paper towels. Replace the magnetic-
head guards.

5. Open the “Maintenance” menu and run the service protocol “MH guard open”. Make sure to replace the

magnetic-head guards before operating the instrument.
Conv se Tray
1. Carcfu@t ¢ the conveyor base tray from below the magnetic head.
2. Soakinag %d quaternary ammonium salt based disinfectant (e.g., Lysetol AF) for at least 15 min.
3. Rinse with atcranﬁpc dry with paper towels. Note: The tray can also be autoclaved at 121°C for 20

min.
O—Ring Replacement O

The O-rings must be changed every %{h using the “O-Ring Change Tool Set” (cat. no. 9019164).

Using the “O-Ring Change Tool Set” to pe{form -ri ange

Before removing the old O-ring, the new O- st.be prepared. These steps should be performed for both
the QIAsymphony SP and the QIAsymphony AS i ments. For instructions, refer to the quick guide that is
included with the “O-Ring Change Tool Set” (cat. no. 4).

6.8 7500 SDS CALIBRATION / VERIFICATION PRO@%

The information for the procedures detailed in this section was taken e, Applied Biosystems

7300/7500/7500 fast real-Time PCR System Installation and Maintenanc . When the yearly calibration
checks are performed, the analyst performing the calibration must check the mp!:sage and status. Procedure
6.8.7.1 details checking the lamp usage and status. The halogen lamp located indthe 7500 SDS Instrument has a
life span of approximately 1,000 hours. If the lamp has exceeded 1,000 hours, or if aghessage is displayed that

recommends changing the lamp, procedure 6.8.7.2 should be followed.

6.8.1 BLOCK CONTAMINATION CHECK &

Purpose: A check for contamination allows a user to determine if there are any areas of possible contamination
in the wells of the plate holder that would artificially increase the fluorescence in those wells during a run,

thereby increasing the quantitation result.

Preparing the Check This check is performed without a plate being positioned in the plate holder; therefore, if

there is a plate in the holder, remove it, and then close the carriage door over the sample block and lock it

down.
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Note: This check is for information only and should not be saved using the 7500 System software during or

after the check. See step 3 below for instructions on documenting the contamination check.

Performing the Check

1. Turn on the instrument and open the SDS software. Click File>New. In the new document wizard click
Finish to accept the default parameters.

2. Clickg g, “Instrument” drop-down menu and select “Calibration”. Click “Yes” to lower the block. In
op” window select Filter A (FAM filter position), open the ROI Inspector and take an image
ting Snapshot.

3. Observe the bac@ fluorescence in the 96 wells. Note any wells that have significant fluorescence;
fluorescence indicate @ ination. For documentation, perform a Screen Shot (Alt + PrintScrn) and
then paste it (Ctrl-V)\inte icrosoft Word blank document.

4. To determine an acceptable back nd fluorescence level:

Push the instrument carriage dgd alloyit to spring back to open it.

Put a new, clean, empty reactio wighout the cover into the sample block.

e oe

Push the carriage forward to close it “
Take another image at 2048 ms. For ddediy€
then paste it (Ctrl-V) into a Microsoft Wo
e. Save as Calibration Contamination check (MM / Y) in the appropriate instrument folder.

ation, perform a Screen Shot (Alt +PrintScrn) and
ocument.

5. If some of the wells still appear to have significant ﬂuores;nce lean them per the instructions in

6.8.2 7500 REGIONS OF INTEREST CALIBRATION

MATERIALS REQUIRED: O@
1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit @

2. ROI Calibration Plate (Part No. 4349415)

“Cleaning the Sample Wells” :
Recheck the wells after cleaning, following steps 1 through 3 above. @

3. Centrifuge and vortex

Purpose:
A Regions of Interest (ROI) calibration maps the positions of the wells on the sample block so that the

software can associate increases in fluorescence during a run with specific wells of the plate. A calibration

image is needed for each well or filter to account for minor differences in the optical path.
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Preparing the Plate

Retrieve the ROI calibration plate from the spectral calibration kit from the freezer in the amplified DNA
room freezer. Allow the plate to thaw. Leave the optical film on the plate. (Do not discard the packaging as
the plate can be used up to three times). Vortex and centrifuge the thawed plate to assure that the liquid is in
the bottom of the plate wells.

Creatig zPhte Document for the ROI Calibration

1. Start Wt and open the SDS software. Load the ROI calibration plate into the plate holder

position.

2. Click File > Ne(<\

In the New Docume ard or dialog box click Finish to accept the default parameters. (The SDS
software automatically savgs % ROI data to a set of calibration files on the computer hard drive). Click
OK if any ROI error is displayed.

3. In the SDS software, select Instru > §alibrate
4. In the ROl inspector dialog box that appcass) click the black area of the window, then select

Display Properties. @
5. Inthe Image Viewer Control Properties dialog Box: i
a. Select Show Saturation }

b. In the Sat Threshold field, enter 4000.

c. Click OK O
6. In the ROI Inspector dialog box, set the lamp control: @
a. Click Block up
b. Select Idle from the Lamp Control drop-down list O

Performing the ROI Calibration

1. In the ROI Inspector dialog box: @

a. In the Exposure Time field, enter 2048 for the 7500 and
b. Select Filter A.

2. Click Snapshot to generate an ROI image.

3. Determine if your ROI image is acceptable. An acceptable image will not have saturated red areas in any
wells. (A few red pixels in a well are acceptable).
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If the ROI image appears over saturated, continue to reduce the number in the Exposure Time Field
(2048) by half until an acceptable image is obtained. Once the acceptable image is produced, print this
screen by pressing Alt + PrintScrn and then Ctrl V into a Microsoft Word blank document.

4. If your image is acceptable, Click Generate Calibration.
The software takes a snapshot, and then displays a message dialog box or an ROl image. A successtul

calibration will have green circles around all wells.

shootin

If th D)n image is not successful, see pg 45 for of the 7500 Installation and Maintenance Guide for trouble

5. Click Save Caliw to save the image for filter A. (An OK will appear in the dialog box for Filter

A). Remember fo S er every filter.

6. Repeats steps 1 throug remaining filters: Filters B, C, D and E. Reset the Exposure Time to
2048 before performing the ¢alibration for each filter.

7. Click Done > File > Close and bli to save the plate document.

Unloading the Plate O
In the ROI Inspector dialog box, click Block Down an@vc the plate. Return the plate to the packaging if

not performing background and optical calibration.

6.8.3  Performing the Background Calibration on th%s Instrument

MATERIALS REQUIRED: /9 !

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit O

2. Background Plate (Part No. 4330124)

3. Centrifuge and vortex @

Purpose A background calibration measures the level of background fluorescence in the instrument. The run
will perform continuous reads of a background plate containing PCR buffer for 10 minutes at 60°C and
average the spectral results to a calibration file. The software can then use the file to remove the background

fluorescence from the run data.

Perform a background calibration after replacing the lamp or monthly, depending on instrument usage.
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Precautions Since the signal consists of fluorescence from several sources it is important to use gloves when

handling the plate, use a clean centrifuge and vortex, and do not place the plates on the lab bench.

Preparing the Background Calibration Plate Retrieve the prepared background plate from the spectral
calibration kit from the freezer in the amplified DNA room. Allow the plate to thaw (Do not discard the
packaging as the plate can be used up to three times). Vortex and centrifuge the thawed plate to ensure that
the liquid js in the bottom of the plate wells.

Creating cWocument for the Background Calibration

1. Place the pr@ plate into the plate holder and close the tray/door. Start the instrument and open the
SDS software. Cli ile > New.

2. Configure the New @ Dialog box:

a. Select Assay >Bac d.
Select Container > 96-Well Clear.
Select Template > Blank éument

In the Operator field, enter
In the plate Name field, enter : B nd_<date MMDDYY> and click Finish.

o a0 o

3. In the SDS software select File > Save As. ]@JO #1, navigate to C:\SDS1.2\Documents and save.

On 7500 #2, navigate to D\: > SDS 1.2 >S nts and save. Select Save as type > SDS
Documents (*.sds).

Performing the Background Calibration In the SDS software :iel e Instrument tab and click Start. The
instrument begins the calibration run after the heated cover comes @Jcraturc. After the run is complete,

1. Click the green arrow or select Analysis > Extract Background. The soft%cts the

click OK. The background run may take 10 minutes.

Analyzing the Background Calibration Data

background signal then displays Background Extraction Complete. Click O

If the message indicates the image exposure is too low, see pg 56 of the 7500 Installation and Ma§ance Guide for
trouble shooting.

2. In the plate document, select the Results tab, then Spectra tab. Print this page for the Background
Calibration records and to show that the instrument is free of significant contaminants.

3. Inspect the raw data for irregular spectral peaks that exceed the following fluorescent standard units
(FSU). All wells should be selected.
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Filter FSU

A,B,C,D >72,000
(7000/7500)

E (7500) >90,000

lf the fluorescence exceeds the FSU indicated, see pg 64 Qf the 7500 Installation and Maintenance Guide for trouble
%)

shogling.
Ifa con@n is observed (high fluorescent data), see pg 108 of the 7500 Installation and Maintenance Guide for

cIeam'ng contaptinants.

D

Inspect the backgroundsptate image for bright areas of fluorescence and perform a Screen Shot (Alt +
PrintScrn) and then @ t;Ctrl-V) into a Microsoft Word blank document for documentation.

e
O
=
X
O
T
%
<
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6.8.4 PERFORMING THE OPTICAL CALIBRATION FOR THE 7500 SDS INSTRUMENT

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit

2. ROI Calibration Plate (Part No. 4349415)

Purpose: Th I%alibration compensates for the physical effects of the additional filter present in the
7500 instrument‘and %0 be performed after every 7500 system background calibration.

Preparing the Optical Cali @ Plate
Retrieve the prepared ROI'pla ‘@ a the spectral calibration kit from the freezer in the amplified DNA room.
Allow the plate to thaw (Do not ¢ sc?\e packaging as the plate can be used up to three times). Vortex and

centrifuge the thawed plate to ensuregthat the liquid is in the bottom of the plate wells.

Creating a Plate Document for the Optical ion

position.

2. Click File>New. ; }
3. Configure the New Document Dialog box: O
a. Select Assay >Calibration. @

1. Start the instrument and open the SDS softwa%he ROI calibration plate into the plate holder

Select Container > 96-Well Clear.
Select Template > Blank Document

In the Operator field, enter a name.
In the plate Name field, enter :
Calibration_<date MMDDYY> and click Finish.

4. In the SDS software select File > Save As. On 7500 #1, navigate to C:\SDS1 .2\% and save.

On 7500 #2, navigate to D\: > SDS 1.2 >SDS Documents and save.

o a0 T

Performing the Optical Calibration
In the SDS software: Select the Instrument tab and click Start. The instrument begins the calibration

run (10 min.) after the heated cover comes to temperature. After the run is complete, click OK.

Analyzing the Optical Calibration Data

Click the green arrow or select Analysis > Extract. The software extracts the optical calibration then

displays a message indicating the extraction is complete. Click OK.

K Forensic Biology Unit Policy Manual v11-25-2019 Page 60 of 82




Unit Policy Manual

Forensic Biology

Click on the Results and Spectral Tabs. Select all wells and print this screen. Inspect the raw background

data for any irregular spectral peaks.

For any error messages, see pg 64 of the 7500 Installation and Maintenance Guide for trouble shooting

1. Applied Biosyste&o Real-Time PCR Systems Spectral Calibration Kit I
(PN 4349180 containing e Plates FAM, JOE, NED, ROX, SYBR Green, TAMRA, and VIC).

2. Centrifuge and vortex

Purpose During a pure dye calibrati({ e system collects spectral data from a series of pure dye
standards and stores the spectral informatiop f pure dye standards in the pure spectra run file, a
calibration file in the SDS directory.

The software then uses the pure spectra data during sx@m runs to characterize pure dyes and distinguish

the individual contribution of each dye in the collective &nce collected by the instrument during a run.

Important! Before performing a pure dye calibration, you m p@n an ROI calibration, a background

calibration, and an optical calibration.

Preparing the Plate Retrieve the pure dye plates from the spectral Calibratii ki m the freezer in the
amplified DNA room. Allow the plates to thaw (~5 minutes). NOTE: Do not remove a pure dye plate

from its packaging until it is ready to be used. The fluorescent dye in the Is of each pure
dye plate is photosensitive. (Do not discard the packaging as the plates can be use ltiple times).
Leave the optical film on the plates. Although multiple pure dye plates are in Spectral Cdki omKit I, only
the plates that are currently used for the quantitation chemistry being employed need to be rag. For

Quantifiler and Quantifiler Duo, only FAM, VIC, ROX, and NED need to be run.

Creating a Plate Document for the Pure Dye Calibration

1. Start the instrument and open the SDS software. Click File > New.

2. In the New Document Wizard dialog box:
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Select Assay > Pure Spectra.

Select Container > 96-Well Clear.

Select Template > Blank Document.

In the Operator field, enter your initials.

In the Comments field, enter the plate bar code number.

—oe a0 TR

Click Finish. Note: It is not necessary to name or save the pure dye plate document. The SDS
software automatically saves the pure dye data to a calibration file on the computer hard drive.

Selecté' zi;iﬁ Dye

In the Pure %ibration Manager dialog box:

In the Dye LigfitieM, select a pure dye to calibrate.

Click Calibrate.
If you are promp @ isconnect the plate document, click Yes.

A message prompts Y, ad the plate. Do not click Yes or No at this point.

Ao o e

Preparing and Loading a Pure Dye pé

1. Remove the appropriate Pure Dye pla
be used multiple times. Leave the optic e plate.
2. Vortex and centrifuge the thawed plate to as agthe liquid is in the bottom of the plate wells.

3. Verify that the pure dye plate that you are about atches the dye selected in the Pure Spectra

Calibration Manager.
4. Load the plate in the instrument with the notch in the uppfr right corner.

Performing the Pure Dve Calibration O

1. In the dialog box that prompts you to load the plate click Yes. The ru ta:‘s ~5 minutes to complete.

2. When the SDS software completes the run, remove the pure dye plate fr e SDS Instrument, place it

back into its packaging, and place it back into its respective spectral calibration kit'in the freezer.

Calibrating remaining dyes: &9&

. Click Next Dye >.
2. Repeat the procedures in Preparing and Loading a Pure Dye Plate and Performing the Pure Dye
Calibration to run the remaining pure dye plates.

3. After you calibrate the instrument with all pure dyes provided in the spectral calibration kits, click
Finish.

Analyzing the Pure Dye Calibration Data
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When each pure dye plate is run, the SDS Software automatically creates and saves a plate document for each
dye. After you calibrate all of the pure dye plates, the plate documents remain open behind the plate

document displayed by the software. To complete the calibration, analyze all open pure dye documents:

From the Windows menu, select the plate document to analyze.

Select the Results tab, then select the Spectra tab.

Select all wells of the plate document by clicking the upper-left corner of the plate grid.

Cw green arrow (or select Analysis > Extract Pure Spectra). The SDS Software completes the
eXtr

B w N =

then displays a message:

If the sochmys: Do this:
Pure Spectra mr%jomplctc — The analysis Click OK, then go to step 5.

is successful. Important! The pure dye

O calibration is not complete at this
point. Before closing the plate document
you must inspect the Spectra plot as

explained in steps 5 through 8 below.

Repair Message—“The following { ire Click OK, then go to step 5.
” ; @ (For information on how the software
auto-repairs calibration spectra, see
O“ out Pure Dye Spectra” on pg 79 of the

4 ied Biosystems 7300/7500/7500 Fast
¢ PCR System Installation and

Maizir%Guide.
7\

repair. . .

Error Message—“Pure Spectra Extraction Click OK, W late, then run the
Detected an Unknown Error. . .” pure dye plate afa
If the calibration ¢ nti}»&o fail, perform

the calibration with a'new py: dye plate.

5. In the pure dye plate document: (@&

a. Select the Results tab.
b. Select the Spectra tab.

6. Select all wells of the plate document by clicking the upper-left corner of the plate grid.

7. Using the tables below as a reference, verify that the peak for the spectrum of the pure dye occurs at the
correct filter. For documentation, Print the spectra for each dye (Alt + Print Scrn; then open a new

blank Microsoft Word document and Ctrl V to paste the spectra). If the peak for the spectra of a dye
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occurs in the wrong filter, you may have run the wrong dye plate during the calibration. Repeat the

procedure using the correct dye.

Instrument Pure Dye Filter | Peak (nm)

7500 System FAM A | ~520 nm i L]

} viC B ~550 nm = 7

NED

ROX

8. Select File > Close. Important! Do not close a plate document until you hQ adted it. During
the calibration, the software creates plate documents for each pure dye plate as it ou must
extract each one individually before closing it.

9. Repeat steps 1 through 8 to extract the calibration data for the remaining pure dyes.

6.8.6 Running the TagMan RNase P Plate Data on the ABI 7500 SDS

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
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2. TagMan RNase P Instrument Verification Plate (Part No. 4350584)
3. Centrifuge and vortex

Purpose The TagMan RNase P Instrument Verification Plate run verifies the performance of an Applied
Biosystems 7500 SDS instrument. The RNase P plate is pre-loaded with the reagents necessary for the

detection and quantification of genomic copies of the human RNase P gene.

The R% contains five replicate groups of standards, two unknown populations and four no template

control wel the run, the SDS software will assess the instrument performance.

Preparing the TagMan BdfNase P Plate Retrieve a prepared TagMan RNase P Verification Plate kit from the

freezer in the amplifiéd D

centrifuge the thawed platg

has a compression pad on it, r t from the plate.

1. Start the instrument and put the RNas @ in the instrument.

2. Open the SDS software and click File > Ne%

3. In the New Document Dialog box:
a. Sclect Assay >Absolute Quantification (stand %e).

b. Select Container > 96-Well Clear.

c. Select Template > AQ RNase P Install

d. In the Operator field, enter a name for the RNase P plate (i.c. P MMDDYY) click Finish
e.

In the SDS software, sclect File> Save As. (Navigate to D\:>A ielBiosystems>SDS Documents

and Save)

Performing the Verification Run In the SDS software: Select the Instrument tab Q tart. (The
instrument default parameters should be correct. The RNase P plate volume is 50ul).

ihs ent begins
the run which lasts approximately 1.5 hours. After the run is complete, click OK.

Analvzing the TagMan RNase P Plate Data

1. Select Analysis > Analysis Settings. Select Auto C, >Click OK. Click the green arrow or select
Analyze.

2. Assess the results. In the plate document: Select the Results tab then select the Amplification Plot
tab.
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4. Display the data: from the Amplification Plot tab:
a.  Click the upper-left corner of the plate grid to select all wells.
b. Select Data > C, vs. Well Position to display the plots. Save this data.
5. Verif) the uniformity of cach replicate population by comparing the groupings of C, values.

If ou li present, omit and reanalyze (see page 93 of the 7500 Installation and Maintenance Guide for
trouble shd0 i% will apply to the 7000, as well).

6. In the results tab@ e Standard Curve tab and Verify that the R? value is > 0.990. Save and print
this data.
7. In the Report tab, calcul@verifieation value of the 5,000-copy and 10,000-copy populations:

a.  For the 5,000-copy populatids, jnsthe Report tab, scroll to a sample in the 5K population. Apply the
value in the Mean Qty and StdDeviQtyfdglumns to the following equation:

5K value = ty + 3(StdDev Qty)

b.  For the 10,000-copy populations, in the Report fab, sgroll to a sample in the 10K population. Apply
the value in the Mean Qty and StdDev Qty colu&h ollowing equation:
y)

10K value = Mean Qty — 3(Std

8. Compare the values of the 10K and 5K-copy populations. If the 10K valfie is greater than the 5K value
the 7500 has passed.

9. With all wells chosen, print the Report. Save the Tabular Report Data and %d. You may

discard the Raw Data and the Delta Rn vs Cycle Data pages. It is recommended (ha &aleulations

performed above be written on one of the Tabular Report Data pages.
10. Close Program. If asked to Save, click “yes”.

Remove the plate and discard. (Note: the plate cannot be re-used)

6.8.7 Monitoring and Replacing the Lamp on the 7500 SDS Instrument

6.8.7.1 Monitoring the Lamp Status
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The halogen lamp located in the 7500 SDS Instrument has a life span of approximately 1,000 hours. If the
lamp has exceeded 1,000 hours, or if a message is displayed that recommends changing the lamp,

procedure 6.8.7.2 should be followed.
1. Select File > New.
2. In the New Document Wizard, click Finish.

S Software, select Instrument>Lamp Status/Replacement. In the Lamp
St %ement dialog box, the usage hours and lamp current are displayed. The Condition field

will indicate &ne of the following:

Good—the @

Close.
Failed—The lamp bu
Change Soon—the lam

ctioning well. There is no need to replace the lamp bulb at this time. Click

be replaced. Click Close, then replace the lamp.

soon. Click Close, then regfface the lamp.

:lbzage is above 2000 hours. It is recommended to replace the lamp

Warning messages may be displayed b @m‘ng a run that indicate Iow lamp current. See page 121 of the
Installation and Maintenance Guidefor theSe @-' es, what they are describing, and how to proceed.

6.8.7.2  Replacing the Halogen Lamp on‘th 00 SDS Instrument

The halogen lamp located in the 7500 SDS Instrument hs ali an of approximately 1,000 hours. If the

lamp has exceeded 1,000 hours, or if a message is displaye thmends changing the lamp, this
procedure should be followed.

MATERIALS REQUIRED: i F

1. Halogen bulb (12V, 75W) %
2. Small pointed object, for example a screwdriver. @

Important: Wear powder-free gloves when you handle the lamp.

1. Power off, then unplug the 7500 SDS Instrument. Allow the instrument to cool for 15 minutes.

2. Open the access door to the Instrument:
Insert a thin screwdriver or other object into the keyhole on the edge of the front access door, then push

to unlatch the door. Open the door.
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3. Remove the lamp from the instrument:
Slide the lamp release lever downward. Firmly grasp the lamp and lift it up and out of the slotted mount.

4. Inspect the lamp for signs of failure (see the Installation and Maintenance Guide page 124 for
indications of lamp failure).

Place the new lamp into the instrument

5
Sh&ﬁlamp release lever upward. Firmly grasp the lamp, place it into the slotted mount, then carefully
C

:ie lamp downward into place.
lo %ss door.

7. Plug in and r on the 7500 SDS Instrument.

8. Open the 7500 S are program.
If the Quick Startup docimient dialog box is not open, select File > New. In the New Document

wizard, click Finish. In thzs software, select Instrument > Lamp Status/Replacement and

click on Reset lamp timer‘the e.

6.

9. Inthe ROI Inspector dialog box, se n Control > Idle.

10. While the instrument is running, look throtigh 4@ rating of the access door and verify that the lamp

is illuminated, then click Done.

Important! After replacing the lamp, the following Calir% must be performed: ROI Calibration,
Background and Optical Calibrations, Pure Dye Calibratioument Performance Verification

(RNase P Plate). /?J,
O@
3
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6.9 PROCEDURE FOR THE CALIBRATION CHECKS OF THE THERMOCYCLERS

The thermal cyclers used for the polymerase chain reaction amplification of DNA are located in the
Amplification Room of the Forensic Biology Unit. A calibration verification test and temperature non-
uniformity test are conducted on each thermal cycler approximately every six months. The verifications are
conducted by an outside vendor.

6.10 3500 Maintenance

OVE F 3500 MAINTENANCE SCHEDULE:

Weekly/ Bi@y (recommended in the following order):
Run the Wash Pumpfand, Channels Wizard (weekly)

Clean anode buffer cup, alve assembly (weekly)
Place new Anode Buff er on instrument (Hard Stop) (bi-weekly)

Replace Cathode Buffer Cafit (Hard Stop) (bi-weekly)

Restart computer and instru nt(ekly)

Monthly:
Flush the Pump Trap
Replace septa on Cathode Buffer Container

Clean the autosampler and drip tray :
Defragment Hard drives 4
As needed: }

Replace Polymer

Spatial Calibration
Spectral Calibration l

Replace Capillary Array (also requires spatial and spectral)

Pump cleaning O
Powering on the 3500 and launching the Data Collection software &9@

1. Power on the computer. At the Log On prompt, log in to the computer.

2. Before turning on the 3500 instrument, ensure that the oven door is closed and locked, that the

instrument doors are closed, and the computer is powered on.

3. Power on the instrument by pressing the on/ off button on the front of the instrument. Ensure that the

green status light is on and not ﬂashing before proceeding.
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4. Click on the 3500 Series Data Collection Software 2 icon on the desktop. Log in to the data

collection software with the password taped to the monitor.

5. Use the Dashboard to review maintenance notifications. When you complete a task, click the green

check mark to indicate that it was completed, or the red X to mark it as dismissed.

6. Click on Maintenance on the top panel. Use the left panel to navigate to the schedule calendar or

ntgnance Wizards to complete the needed maintenance.
Weekl ance

At least 30 minute@te beginning weekly maintenance, bring Conditioning Reagent, POP-4

Polymer*, Anode buf} ainer, and Cathode Buffer Container to equilibrate to room temperature.
*If polymer remains b xpiration date, and there are still injections left in the pouch, polymer can
be reused for a total of appfox ely four weeks on the instrument before it needs to be replaced.

Run the Wash Pump and Chél izard

\)

‘Maintenance Wizards’ on the left to find

This wizard takes about 40 minutes from# inish. Click ‘Maintenance’ on the top panel, and

Dashboard | Edit * Maintenance  Tools ¥ Manage ¥ Preferences Help ¥ LogOut

applied

rary
Maintsnance |
® biosystems™
| Camrate ‘Which maintenance task would you like to perform?

Spatisl
Spectral

Performance Check Install

Capillary

Fill
i INSTALL & capillary array FILL the ag sh polymer
Sequencing Install Standars Array Palymer

Fragmentinstal Standan

HID Install Standad

Fianned Mantenance

Remave

Notficstions Log Bubbles REMOVE bubbles fram the polymer pump
servicelag

REPLENISH the polymer ins@ nt

CHANGE the type of polymer installed on the instrument
with the opfion 1o change arrays

Schedule

Usage

Wash

WaSH the pump chamber an:

Channels

: _"—| ——
S Shutdewn
\ the
A N SHUTDOWN the instrument
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Follow the wizard prompts to empty the anode buffer (NOTE: The EMPTY anode buffer container is placed
back on the instrument for the water wash), remove polymer, insert conditioning reagent, and insert

polymer to flush the pump chamber and channels.
Clean anode buffer container valve pin assembly

Following pump chamber and channels wash, and before installing the new anode buffer container, use a

cle ree cloth and deionized water to wipe clean the anode buffer container valve pin assembly on the

poly @ry pump.
Place new PA& Buffer Container on instrument

1. Remove Anode Bu Gntainer from outer plastic wrap. Ideally, this is done after the wash pump and

channels wizard.

2. Tiltit slightly to make surc'that sfiost of the buffer is in the larger side of the container. There should be
less than 1 mL of buffer remainipg i small side of the container. Verify that buffer is to the fill line.

does spill into the overfill side, pipette it b o the reservoir so that the liquid reaches the fill line.

3. Gently peel off the plastic seal on the t' 0 it spilling any into the small side of the container. If it

4. Place the Anode Buffer Container (label side first) fin he valve pin assembly, and slowly slide the lip
of the container into the locks.
Replace Cathode Buffer Container (replacing septa on@e er month)

1. Remove Cathode Buffer Container from outer plastic wrap and pee f%c seal from the top,

ensuring that it is peeled off of every circular opening.

2. Wipe off any buffer on top of the container with a lint-free cloth. Ensure tha%f itis dry.

3. Press tray on the front of the instrument to bring the autosampler forward. Remove@l cathode
buffer by pinching in the middle.

4. Place the appropriate cathode buffer septa on both sides of the cathode buffer container. These only

need to be replaced once per month. Septa can be washed with water and returned to the new cathode

buffer.

5. Install the new buffer by clickjng it into the tabs on the autosampler.
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6. Close the instrument door to re-initialize.
Restart computer and instrument
1. Close data collection software.

2. Shyt down computer.

3. 0 @mter is shut down, press the power button on the instrument.

4. Restart CO@K don’t log in.

5. Once the compute turn the 3500 back on by pressing the power again. Let the instrument
S

initialize and wait fog the'sghid green light to appear before logging on to the computer.

6. Click on the 3500 Series Data £ollection Software 2 icon on the desktop. Log in to the data
collection software (it may ta a?e for the connections to be reestablished before the software can

%

open).

Monthly Maintenance

Flush the Pump Trap

by cleaning any diluted polymer and clearing air bubbles.

1. Fill the supplied 20 mL, all-plastic Luer lock syringe with nanopure ia%o not use a syringe smaller

than 20 mL. Doing so may generate excessive pressure within the trap Xpela&bubbles from the

The water trap must be flushed once per month (or more of%ied) to prolong the life of the pump

syringe .

2. Attach the syringe to the forward—facing Luer fitting at the top of the pump block@ fitting with
one hand while threading the syringe onto the fitting with the other hand.

3. Open the Luer fitting by grasping the body of the fitting and turning it to loosen. Attached syringe and

turn counterclockwise approximately one half turn.

IMPORTANT! Do not use excessive force when you push the syringe plunger as this may damage the trap
seals. Take approximately 30 seconds to flush 5 mL of nanopure water through the trap.
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4. Remove the syringe from the Luer fitting. Hold the fitting with one hand while turning the syringe

counterclockwise with the other hand.
5. Close the Luer fitting by lightly turning clockwise until the fitting seals against the block.
6. Dispose the excess water inside the overflow container.

R%epta on Cathode Buffer Container

Once p Wange both of the septa on the Cathode Buffer Container during the weekly

maintenance. A

Clean the autosamp@nd drip tray

Wipe them down with a li@vloth and either deionized water or absolute ethanol

Defragment hard drives (

Click the Windows Start icon to find efragmenter and open it. Click on each disk and click
‘Analyze’ to determine the degree of fragme 1. Click ‘Defragment’ for every disk that is
fragmented. This may take several minutes to hour, ding on the degree of fragmentation.

As Needed Maintenance ;}
Replace Polymer O E

If there isn’t sufficient polymer to complete your run or if the polymer a'wkded 4 weeks use on the
instrument, it is necessary to place a new polymer pouch on the instrumerft. Get a pew polymer pouch and
let it equilibrate to room temperature before replacing the old one. Use the Replenish Polymer wizard

to complete this. Follow the wizard prompts in order to flush the pump of the o | and refill the
capillaries with the new polymer. This wizard takes 10-20 minutes to complete &

Spatial Calibration

The 3500 Series Data Collection software uses images collected during the spatial calibration to establish a
relationship between the signal emitted by each capillary and the position where that signal is detected by
the CCD camera. A spatial calibration is required to ensure correct alignment of the capillaries and optimal

detection of the signal in each capillary.

A new spatial calibration is recommended when:
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® A capillary array is installed, replaced or temporarily removed from the detection block
®  The instrument is moved

®  The detection cell door is opened

Perform Spatial Calibration and Evaluate Results

1. Cligk ‘Maintenance’ on the Dashboard. Click ‘Spatial’ under the Calibrate heading on the left.
2. Seledt No JFill, or select Fill to fill the array with polymer before starting the calibration.
3. Click ‘Stafrt Calibgation’. The display updates as the run progresses.

4. When the run is cofnplet®, evaluate the spatial calibration profile to ensure that you see the following:
®  One sharp pcakgqr dach capillary. Small shoulders may be acceptable.
®  One marker (+) 4t the apex of every peak. No off-apex markers.
®  An even peak profile€all peaks about the same height).
®  The Max Spacing — Min SpagingShould be no more than 2 pixels.

5. If the results meet the criteria above, click {Accgpt Results’.

Note: If any peaks are lower than usual for the instrunjentef the heights drastically slope up or down,

repeat the calibration with a fill. See below for an example)of amjgcceptable Spatial Profile.

-=00 - T T T . T T T T T T
] 100 200 300 400 coa
6. Click ‘View Spatial Calibration Report’.
Spectral Calibration
A spectral calibration creates a matrix that corrects for the overlapping fluorescence emission spectra of the
dyes. Although cach of these dyes emits its maximum fluorescence at a different wavelength, there is some
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overlap in the emission spectra between the dyes. The goal of multicomponent analysis is to effectively

correct for spectral overlap and minimize the presence of artifacts, such as spectral pull-up, in the data.

A new spectral calibration is recommended/required when:
®  The capillary array is changed (required) or temporarily removed from the detection block.
e  The instrument is moved.

@ The laser or CCD camera has been realigned/ replaced by a service engineer.

n increase in (pull-up and/or pull-down peaks) is observed.
w dye set is used on the instrument.
. "l%jillary array length or polymer type is changed.

®  The degéctian cell door is opened (not required by the software, but recommended).

Perform Spectral Calib Evaluate Results

1. Pre-heat the oven by clicking ?‘t Pre-heat’.

Note: Preheating for approximately %ﬂ helps mitigate subtle first-run migration rate effects. The
pre-heat function automatically turns off urs.

2. Click ‘Maintenance’ on the Dashboard. tral’ under the Calibrate heading on the left

panel.

3. Check the pump assembly for bubbles and run the Remo%wizard if needed.
1x@

For GlobalFiler® and Yfiler™ Plus analysis, use Dye Set J6. O

4. Vortex the appropriate Matrix Standard. Prepare the Master

a. Standard: 10 pL
b. HIDI Formamide: 290 uL

Note: Volumes other than above may be used to obtain spectral peaks between 3000—10,@. The total

volume should not exceed 300uL.
Note: After a capillary array is changed, a new spectral calibration must be run for each dye set.

5. Load 10 uL of matrix standard/HIDI mixture into wells A1-H1 of a 96-well reaction plate. Note:

multiple matrix samples (i.e., J6 or G5) can be run in subsequent columns on this plate if needed)
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6. Cover the plate with a 3500 septa mat and centrifuge to ensure that the samples are at the bottom of the

wells and place the reaction plate in the Veriti® thermal cycler.

7. Denature the samples by running the spectraldenature protocol on the Veriti thermalcycler (95°C, 5

min).

he cover plate of the Veriti® thermal cycler may be closed onto the septa mat-covered reaction
putpdo not clamp the cover down. Although the lid is not heated during the denature protocol, it
éw e septa mat and pull it up when the cover is opened if it is clamped down.

8. After the @raﬁon protocol is finished, chill the reaction plate immediately in the 96-well cooling
block (-20°C) Wast 3 minutes.

9. Place the plate into@) ies 96-well plate base (it will only fit in one orientation) and cover with a
3500 Genetic Analyzer 96- plate retainer. Check to ensure that the retainer clip is properly seated.

10.Press the tray button on the fropft of the 3500 Genetic Analyzer. When the autosampler tray presents
itself, open the door of the ingn nd place the tray onto the either position of the autosampler
(the tray will only fit in one orientati @t the plate toward the middle, first before lowering into the

side clip. Close the instrument door.

11.In the 3500 Series Data Collection Software ;, @Waintenance’ on the dashboard. Click
lefi

‘Spectral’ under the Calibrate heading on the

G5). Select allow borrowing.

13.Click ‘Start Run’. Run takes ~30 minutes to complete. Passing cajllar s are shown in green and
failing capillaries are shown in red. Borrowed capillaries are shown in y¢llow with an arrow indicating
the adjacent capillary from which results were borrowed. O

14.Evaluate each capillary for the following: %

®  Order of the peaks in the spectral profile from left to right:

12.Select the number of wells (96), plate position, chemistr% (Matrix Standard) and dye set (J6 or

J6: blue, green, yellow, red, purple, orange (an example is below)

®  Peak heights are sufficiently robust (>2,000 RFU) and do not contain extrancous peaks, gross
overlaps, dips, or irregular morphology. If peak heights exceed 20,000 RFU, set up another plate
with a reduced amount of matrix standard. If peak heights are below 2,000 RFU, set up another
plate with an increased amount of matrix standard. See below for an example of an acceptable J6

spectral profile. G5 is similar, but without the purple.
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15.1f the results meet the criteria above, click ‘Accep

lts’. If the results do not meet the criteria, set
up another plate, adjusting amount of matrix standard,‘if ngCesSary, and run again.

Installing or replacing the capillary array
It is recommended that the capillary array be replaced after 160 injections Jr capillary, or removed from
the instrument for storage if the instrument is to be shut down for an extended p¢friod of time; however,

capillary life may be extended based on the quality of the data obtained from th (9

Select the ‘Install Array Wizard’ for guidance. This wizard takes 15-45 minutes to c@.

Note: A spatial calibration AND spectral calibration are required after a capillary array change. The

instrument will not run without a new spectral calibration associated with that capillary RFID tag.
Removing bubbles from the pump block
Periodically, check the pump chamber, channels and tubing for air bubbles. Press the button on the right

hand side of the front of the instrument to turn on the lamp inside the instrument. This will help locate any

air bubbles.
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Select the ‘Bubble Removal Wizard’ for guidance. This wizard takes 5-15 minutes to complete.
Pump Cleaning
In nearly all circumstances, the Water Wash Wizard is very effective in cleaning the pump assembly.

Occasipnally, a situation in which the Water Wash Wizard is not sufficiently effective may arise. If polymer

has djn the channels of the lower block, or if some contamination in the pump assembly is suspected,

use @Cleaning Kit to thoroughly clean the pump assembly.

If this proced& needed, refer to the Pump Cleaning Kit Protocol for 3500 Series Analyzers.

REFERENCES:
Applied Biosystems 35 L Genetic Analyzer User Guide

Applied Biosystems 3500/ Genetic Analyzer User Bulletin
Product insert sheet from Dy¢'Set J§ (Pub. Number 4426042 Rev. A)

Pump Cleaning Kit Protocol for ﬁs Analyzers
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7.0 COLLECTION KITS AND SUPPLY ORDERING

7.0 PREPARATION OF EVIDENCE COLLECTION KITS

The Forensic Biology Unit provides officers, investigators, and sexual assault nurses with six types of kits used in

the collection of biological evidence.

In geneWaboratory Technician is responsible for preparing and disseminating the kits, however, the unit
as a whole 15 1 sible for these kits. A point person may be assigned the responsibility of these kits. A
minimum stock*sfiou kept on hand at all times in order to fill requests promptly. Kit components should
also be prepared a ke%ind. Kits and kit components should be made on a sterile surface. Use protective

gloves and a laboratory abwhen preparing and handling kits and kit components.
7.0.1 REFERENCE M AB COLLECTION KITS
Keep 60-100 kits on hand at all time(

Place the following items in a Reference Mi &ib Collection Kit envelope (a manila envelope with ‘SDPD

REFERENCE MOUTH SWAB COLLECTI Ointed on the front):

= 2 sterile, paper-wrapped swabs @

® 1 small “SDPD Reference Mouth Swabs” envelope

® 1 smaller manila envelope }

= 1 evidence seal

® 1 pair of large nitrile gloves Q

® 1 copy of ‘Instructions for the Collection of Reference Mouth Swa @

® 1 copy of the SDPD consent form

Individual kits can be packaged together in large paper bags containing 20 kits. O

7.0.2  BIOLOGICAL STAIN COLLECTION KIT &9@

Keep 60-100 kits on hand at all times.

Place the following items in a Biological Stain Collection Kit envelope (a manila envelope with ‘BIOLOGICAL
STAIN EVIDENCE COLLECTION KIT’ printed on the front):

= 2 sterile, paper-wrapped swabs
® 1 tube containing sterile water
® 1 small ‘SDPD BIOLOGICAL EVIDENCE SAMPLE’ envelope

® 1 smaller manila envelope
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1 evidence seal
1 pair of large nitrile gloves

1 copy of ‘Instructions for the Collection of a Biological Stain’

7.0.3  VICTIM SEXUAL ASSAULT EXAMINATION KIT

Keep 60-80 kits on hand at all times.

Place @ ing items in a Victim San Diego Regional Sexual Assault Evidence Collection Kit envelope:

5 swube tube

1 Pubic Hair Co%envelope with comb
1 Head Hair envélop® with bindle

1 Left Fingernail Scra @

1 Right Fingernail Scrap

nvelope with 2 fingernail swabs in a bindle
lope with 2 fingernail swabs in a bindle
1 piece of tissue paper

Swabs sticker, 1 Left Breast Swabs, an t Breast Swabs sticker)

1 evidence seal <
1 victim label sheet (1 Cervical S aEinal Swabs, 1 External Genital Swabs, 1 Oral swabs, 1 Rectal

Keep 40-60 kits on hand at all times.

7.0.4  SUSPECT SEXUAL ASSAULT EXA ION KIT

Place the following items in a Suspect San Diego Regional Sexua@ft Evidence Collection kit envelope:

5 swube tubes
1 Pubic Hair Combings envelope with comb l

1 Head Hair envelope with bindle

1 Pubic Hair envelope with bindle
1 Left Finger scrapings envelope with 2 fingernail swabs in a bindle

1 Right Finger scrapings envelope with 2 fingernail swabs in a bindle &9@

1 piece of tissue paper

1 evidence seal

1 suspect label sheet (1 Penile Swabs, 1 Scrotal Swabs, 1 Oral swabs, 1 Left hand fingers swab, and 1 right
hand fingers swab stickers)

7.0.5 PHYSIOLOGICAL SAMPLES KIT

Keep 60-80 kits on hand at all times.
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Place the following items in a Physiological Samples San Diego Regional Sexual Assault Evidence Collection

Kit envelope:

® 2 grey-capped blood vials (Vacutainer®) each in a cigar tube
® 1 urine bottle with sodium fluoride

® 1 custody seal

= 1 evidence seal

Blood vi igar tubes are provided by the Narcotics Unit.

7.0.6  FET Lﬁ)E COLLECTION KIT
Prepared as needed. A

Place the following items in a nvelope:
® 2 blue-capped 50mL conical vial(is a sPare)

Evidence seals
®  Procedure for collecting aborted fetal
® 1 pair of large nitrile gloves O
A cooler and ice pack will be provided to any investigatoi ansporting the fetal material to the Property
Room. Reference mouth swab collection kits should also be %to investigators for the purpose of
collecting samples from the mother and alleged father. O
7.1 ORDERING AND RECEIVING COMMERCIAL KITS @ !

7.1.1 Ordering procedure

Requests for supplies, reagents, and DNA typing kits will be placed in the Supply OQ@electronic file)
located on the department network (G:\Laboratory\ Annaliese\ Ordering, Quotes, PO Log
AHD .xlsx)

When orders are placed, the date ordered and the order confirmation number will be logged into the Supply
Order Log.

7.1.2  Receiving supplies

The receipt of the supplies will be logged into the Supply Order Log. The packing slip received with the
supplies is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the

laboratory.

Forensic Biology Unit Policy Manual v11-25-2019 Page 81 of 82

%




-

Unit Policy Manual

Forensic Biology

7.1.3  Receiving chemicals

The receipt of the chemicals will be logged into the Supply Order Log. The packing slip received with the
chemicals is initialed and dated then submitted to the Administrative Aide in Charge of purchasing for the

laboratory.

A recWe chemicals on hand in the Forensic Biology Unit will be maintained. Any new chemicals (i.e.

not previ ered/received) will require an MSDS to be on file in the Unit.

Chemicals need U%ve the date and the initials of the receiver on the container.
7.1.4  Receiving DN

The kits used for DNA extrac@antification, and typing must all be recorded in the Kit Receipt Log upon

receipt. In general, the lot numbgrs of ghery component of the kit are recorded as well as the lot number of

the kit. Kit components may be storéd in different locations and, thus, all kits components must be labeled

.g.§F#—YY).
7.1.4.1  QUANTIFILER KITS

Record lot numbers of the PCR reaction mix, Q rd, primer, and whole kit in the Kit Receipt Log.
The PCR reaction mix should be labeled with the wholf¥it lot number and stored in the reagent
refrigerator. The remainder of the kit (in the original 1 :e stored in the reagent freezer. Place ‘Not

with the laboratory—designated lot num

QC’d, Do Not Use’ stickers on all kit components. Replace wj C OK” stickers once the quality control

tests have been completed and reviewed.

7.1.4.2  STR TYPING KITS

Record lot numbers of all components of the kit and the whole kit lot numb he Kit Receipt Log. The
PCR reagents box should be labeled with the laboratory-designated lot number angfstored in the reagent
refrigerator. The ladder will be labeled with the laboratory—designated lot numb ed in the reagent

with “QC OK? stickers once the quality control tests have been completed and reviewe

freezer in the Amplification Room. Place ‘Not QC’d, Do Not Use’ stickers on all kit {£o &nts. Replace

7.1.4.3  QIAGEN DNA INVESTIGATOR KITS (EZ1 or QiaSymphony)
Record lot numbers of all kit components, except the buffers and proteinase K, and the whole kit in the Kit

Receipt Log. Discard the proteinase K and buffers. Place ‘Not QC’d, Do Not Use’ stickers on all kits until
quality control testing has been completed. Replace with “QC OK” stickers once the quality control tests

have been completed and reviewed.
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